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Introduction

This book spans approximately six years of technical writing by me, begin-
ning with the first version of Windows Tips newsletter that I have on record
and ending with writing from barely a week ago, the latest thing I had at
press time.

Part I, Windows Tips, consists of eight issues of Windows Tips. Windows
Tips was a monthly (later semi-monthly) newsletter which contained tips
on Windows, Microsoft Word, Firefox, Internet Explorer, and random other
things. At some point, the column “Crazy Computers” was also added, which
was usually a rant on some stupid thing the computer had done to me over
the past month. Windows Tips ran for probably about two years—the issues
in this book run from October 2005 to December 2006. However, I’ve lost
quite a few other ones due to what I call my Hurricane File System—a term
which describes the utter disarray that all my files from before approximately
ninth grade are in. 1

Part II, Technical Geekery Tips, contains the Technical Geekery Tips
newsletters from 2008. The newsletter also ran during 2009, but due to
both length and formatting issues, I decided to include only the first year.
Technical Geekery Tips was almost identical to Windows Tips, except for
the name and the fact that it was a fresh start. It also had a more regular
schedule than Windows Tips—I didn’t miss any issues at all in 2008, and did
fine for the first half of 2009 as well. After that I got behind, and that was
part of why I discontinued it at the beginning of 2010. (The other part was

1This happened partly due to poor organization, but also due to the fact that I rein-
stalled Windows probably seven or eight times during that time. My general practice upon
reinstalling the operating system used to be to place my old desktop and My Documents
folders in a folder called “Old” or something similar, which has led to up to five levels of
nesting in some places. Unsurprisingly, duplicate copies of everything abound, and so do
missing things—I have at least one file that I have four copies of, none of which contain
the entire document.
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8 CONTENTS

that I just didn’t really feel like doing it anymore.)
Part III, the Technical Geekery Blog, contains fewer tips and more opin-

ions. It ran from October 17, 2009 to August 11, 2010. This slightly overlaps
the period of Technical Geekery Tips, but all the issues that are included in
this book were written before the blog existed. To be consistent with the rest
of the book, the oldest entries are presented first, the opposite of the order
in which a blog would normally be presented.

Part IV, Technical Geekery Quick Tips, is my most recent work (it started
in the summer of 2011 and is still going). It is a weekly email/blog post that
discusses either a tip for using computers or a concept in computers.

In Parts I and II, I left out the Announcements columns and other repet-
itive things on a few occasions, and on all four parts I left out any posts that
relied heavily on media or that I otherwise couldn’t duplicate. There weren’t
all that many of them, though.

Keep in mind that Part I, Windows Tips, is now five years old, which is
a long time in the world of computers. A lot of the stuff still applies, but
any tips talking about software you should download are probably horribly
out of date. Otherwise, I don’t think I have any advice you shouldn’t follow
(I tried to put footnotes in any places where updates were really important).

There’s an index in the back; if you don’t want to read the whole book,
browsing through the index for interesting-looking tips might be a nice way
to read.



Part I

Windows Tips
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1: October 2005

Five Ways to Delete a File [September, October] (Until
November 2005)

� Click the X button on the toolbar.

� Click File>Delete.

� Press the ‘delete’ key.

� Right-click, choose ‘delete’.

Windows Explorer

Press (Windows key) 1+ E to start.

Internet Explorer

Sorry, no more tips here till you switch to Firefox.

Firefox

Do you know how those browser windows always pile up? Have you ever
wanted more than one home page? Probably the answer is yes. Well, now
you can have lots of pages in one window and even have as many home pages
as you want. To get started, press the keystroke Ctrl + T. A new bar will
appear along the top. This is called the Tab bar. You can switch between
any pages you have open by clicking on the tab of that page. You can open
a new tab anytime by right-clicking on the Tab bar and clicking New Tab.

1There was a really terrible line drawing of the Windows logo here originally.
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12 1. OCTOBER 2005

To make a multiple-tab home page, open all the pages you want in tabs,
then go to Tools>Options. On the left there will be five tabs. Make sure you
are on the General tab, then click the Use Current Pages button. Click OK
and close the browser.

Don’t have Firefox? Download it now at: http://download.mozilla.

org/?product=firefox-1.0.7&os=win&lang=en-US Your download will start
automatically after confirmation.2

Microsoft Word

Press Ctrl + Shift + L to start a bullet list.

Notepad (One Time)

Want a journal that automatically inserts the time and date for you? Here it
is. Go to Start>Run and type ‘notepad’. Type ‘.LOG’ on the top line (case
sensitive) and close the file. Tell it to save it when it asks. Open it again
and it will insert the time and date at the bottom of the document.

Crazy Computers (by Soren Bjornstad)

Not so long ago, I got a message like this one:

What exactly does it mean, “Are you sure to kill the process?” Well, it

2Don’t go here now. This link probably won’t work, and if it does you’ll get Firefox
1.0 (the current version is 9 as of this writing).

http://download.mozilla.org/?product=firefox-1.0.7&os=win&lang=en-US
http://download.mozilla.org/?product=firefox-1.0.7&os=win&lang=en-US
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certainly doesn’t mean what it is supposed to mean. Too many programs
now don’t have proper text, and this one sure comes in that class. There are
bound to be more with the same sort of thing, and some of those will un-
doubtedly, and unfortunately, have worse results. Eventually, some of these
will probably get fixed eventually, but in the meanwhile, we will probably
just have to deal with crazy boxes.

If you have any crazy computer things, take a screenshot by pressing the
Print Screen button (sometimes labeled PrtScn or Print Scr) and send it to:
sobjornstad
@yahoo
.com.
(Split-line to prevent worms from getting the address)
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2: December 2005

Windows Tips December 2005 (Last Issue of Year)

This Windows Tips version is early. The next issue will be mid-to-late-
January.

Five Ways To Delete A File (Ending this issue)

Drag the file to the Recycle Bin.

If you have missed any earlier ones or forgot some, the complete list will be
posted at Windows Tips Club. To get in to this club, you have to use one
or several of my tips. If one of these has really helped you, send details,
the issue, and the tip to Soren Bjornstad and I will send you the password.
Please do not give the password to anyone else.

Microsoft Word

Ever wanted to save text in a document? Well, now you can do it easily, in a
separate file! Just drag any text in a document to the desktop or any other
Windows Explorer window. (Press Windows + E to get a new Windows
Explorer window.)

Bonus Tip: For drag-and-drop haters, copy and paste works too.

Extra Tip: You know how, when you turn Caps Lock on and type without
knowing it, it ends up looking bad. The only way to fix it is to delete it
and start over. Or is it? If you are using Microsoft Word, you can go to
Format>Change Case and choose Sentence Case. Any title capitalization

15



16 2. DECEMBER 2005

won’t be fixed, but that is a lot less to fix than typing the whole thing over.
You can use this for lots of case changes. But the best trick? To change
from a different case to sentence case, use the shortcut Alt + S-o-r-e-n-’-s +
Enter. Cool!
Note: You may hear some error beeps in the middle of the keystroke, but
nothing is wrong.

IE/Firefox

For Firefox non-users, you get a tip this month.
Ever wanted to get to a favorite website really fast? Sure, you could put it
in your Favorites or Bookmarks, but there is an even faster way. Right-click
the desktop, choose New Shortcut, and type the address into the box. Click
Next and type a name for your shortcut. Click Finish and put the shortcut
on your desktop or Quick Launch bar. Of course, it doesn’t have to be there.

Notepad (This may be the last time Notepad appears)

Think the font in Notepad is so dull? Well, it doesn’t have to show up
that way. Click Format>Font and choose something really snazzy or at least
something good enough to look decent, like Times New Roman.

Windows Explorer

OK, you have a folder full of pictures and want to see a slideshow. The task
pane isn’t out, and you have no idea how you are going to get a slideshow.
Right-click on the first picture, choose Open With, and choose Windows Pic-
ture and Fax Viewer. Make sure the window is selected, and press F11. It
is at the top of the keyboard close to the right, unless you have an archaic
keyboard. If you hate using keyboard shortcuts, the button is fifth from the
right and is a picture of a screen.

Bonus Tip: If you find a picture that needs to be rotated within a slideshow,
press Ctrl-L or Ctrl-R. If you don’t want to use the keyboard, right-click and
choose Rotate [direction].
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General Windows

Refer to the attached document1 about the Indexing Service. It doesn’t
look too nice, because after all it is a .msc console, a Management Console,
but if you leave your computer idle long enough, it will find files in a snap.
Try to only use it for Word documents, because you can’t always find other
documents with it.

Programs to Get

These programs will have a tip column in the future.

� StatBar- What a neat program! It well show you practically everything
about your computer. As an added bonus, it shows buttons to launch
programs. Cleaner desktop ahead!

1I dived into my Hurricane File System to find this one, and this time I found it pretty
quickly because I actually knew part of the title. It’s not very interesting, though, so I
decided not to include it.
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3: February/March 2006

I am sorry about the January edition not getting out. I was busy and forgot
about it. The Windows Tips Club (and the rest of the website) are both
down. I will notify you when I can get them working.

Microsoft Word

All right, this one is a bit dull, especially for people who don’t like using the
keyboard commands, but here goes:

Those special characters can get kind of annoying sometimes, going to
your menu every time. So, you can use these “simple” (kind of) keystrokes:

To use these, turn Num Lock on and prepare to enter numbers. Hold
down the Alt key and key in the numbers shown below. Release Alt, and the
symbol jumps into your document.

©: 0169
®: 0174
¼: 0188
½: 0189
¾: 0190

There are plenty of other ones too. To find more, go to Start >Run and
type charmap, then click OK. Click the letter or symbol you want to know
the code for, then look in the lower-right corner of the window. You will see
a notation that looks somewhat like this:

U+00C9: Latin Capital Letter E With Acute Keystroke: Alt+0201

Where it says “Keystroke” in the right, type those numbers into your
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20 3. FEBRUARY/MARCH 2006

keyboard using the technique described. Note that not every symbol has a
code.

IE/Firefox

This month is a bit of an extension. All credit to Windows XP Hacks &
Mods for Dummies, Second Edition. It is a faster way to get the shortcut
described in last month’s tips.

Ever wanted to get to a favorite website really fast? Sure, you could put it
in your Favorites or Bookmarks, but there is an even faster way. Right-click
the desktop, choose New Shortcut, and type the address into the box. Click
Next and type a name for your shortcut. Click Finish and put the shortcut
on your desktop or Quick Launch bar. Of course, it doesn’t have to be there.

Well, even easier! See the little icon to the left of the URL? Drag it to
the desktop and you have a shortcut! 1

Notepad (This may be the last time Notepad appears
{again})

NOTEPAD PRINTS VERY FUNNY! Okay, okay, it’s livable, but annoying.
It puts the filename at the top of each page. To get rid of this nonsense,
start Notepad, go to File>Page Setup, then delete the “&f” code symbol in
the box. This should take care of it.

General Windows

Keystroke-Lovers’ Tip: Alt-F4 will close any Windows program.

StatBar

Since StatBar has never been in here before, I am going to tell you a little
bit about it. The program can show you lots of things. I will suggest some
useful panels, but you can do anything you want. Right-click anywhere on
the bar and choose StatBar Configuration.

1There were originally some screenshots here. They would be a big pain to include and
didn’t add much, so I left them out.
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1. It’s up to you to choose if you want the Win XP text at the left. It’s
called Windows Version in the configuration window. It seems like
there would be no point in keeping it there, but if you mouse over it,
you will see more info about your version. It could be a little useful.

2. If you use power-saving functions or just hate leaving your computer
running too long, get the Windows Uptime module. This tells you how
long your computer has been running. It’s a good idea to restart your
machine if it goes over 2 days.

3. GET THE LOCKS STATUS MODULE! Pretty self-explanatory, but
it also shows the status of the Insert key. Hurray!

4. I wouldn’t get the CD Door Eject/Close module. Although it seems
useful, I almost never used it when it was there.

5. Skip the Master Volume Control. You can get a much easier one on
Desktop Sidebar.

6. If you use dial-up internet, get both the Dial-up Networking Status and
the Network Traffic Meter. If you use cable or DSL, get just the NTM,
if you want to take charge of your connection, that is, and keep the
computer from hiding the details.

7. Get the CPU Usage, even though Desktop Sidebar has a good one,
because it has a history graph, something DSidebar doesn’t have.

8. If you are looking for something to fill more space at the end of your
panel-adding frensy, then get the RAM Usage module.

9. I would recommend the Time synchronization module unless you have
absolutely no space. It lets you change the time intervals better, and
you can manually synchronize by double-clicking.

10. I would take the Quick Launch. Setting it up is a little strange, but if
you don’t try to browse for a folder, it should work just fine. To add
something, go to the File Paths button on the left.

11. If your primary email address goes to a desktop email program such
as Outlook or Thunderbird, the Email Launcher would be worth it. It
creates a new, blank message.
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12. Get the Disk Info. It takes about 20 pixels, and clicking it tells you all
about your drives and also how much your machine and all removable
drives are together able to store and how much has been used.

Once you have added these, you should flip a few config switches.

1. Under Module Selection, choose Remember this selection when screen
resolution changes. Can’t live without it.

2. Under General Options, uncheck Open Website on logo double-click. I
have been transported to their site accidentally many times.

3. If you use XP, you may want to make it slightly transparent. If you
decide on it, choose 15

4. Networking just lets you choose a time server. Borrrrrring.

5. Enjoy StatBar!

Programs to Get

These programs will have a tip column in the future.

� StatBar- What a neat program! It well show you practically everything
about your computer. As an added bonus, it shows buttons to launch
programs. Cleaner desktop ahead!

� Desktop Sidebar – The best add-on to the taskbar and desktop
ever! It has a performance space that can be added. Prepare,
though, to spend a few minutes customizing it. If you are
really crazy about what is on it, you may spend several hours.
(I did.) If you are low on screen space, you can set it to auto-
hide, even telling it a delay time between moving your mouse
to the side and it popping out.

Email Fraud Woes

This column will replace Crazy Computers this issue.
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Hello, my name is James Duran. I live in Chicago, Illinois. I wanted

to know on a scale of one to ten, one being the worst, what you would

rate this program. I would give it an 8.

James Duran

How about this message for an attachment fraud? Like I would open this
attachment!

The attached PDF, How to Prevent Internet Fraud, will provide a little
bit of insight on avoiding email viruses and other email fraud. 2

NOTICES

Windows Tips is getting to be a pretty big thing. I just don’t have the time
to write a five-page newsletter every month. It will be scheduled for two
months; they may come out early, but don’t bet on it.

If anyone has a tip that they would like published, let me know! My ad-
dress is sobjornstad@yahoo.com. Feel free to email me about the newsletter
and/or your tips.

Please excuse the large size of Windows Tips. I am doing all I can to
keep the size to a minimum, but all these high-quality (though I’m working
on this too) pictures make the size shoot up fast.

Many people have probably missed the so-called “attached” file on the
Indexing Service last issue. It is in this series of attachments.

2Once again, I didn’t really feel like including this was worth it.

sobjornstad@yahoo.com
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4: May 2006

Microsoft Word

I never thought I would be speaking against my own software, but here goes:
Don’t download or install the Improved template. It has several bugs in it,
and the installation is wrong. I plan to take it down soon.

IE/Firefox

The Google Toolbar is a handy add-on to both IE and Firefox. A fancy
feature about downloading it: the page autodetects whether you have IE or
Firefox and gives you the appropriate version.1

Download at: http://toolbar.google.com

Notepad (This isn’t a tip about Notepad)

Tip: Don’t get Ultra-Edit 32. It’s a nifty text editor, but hardly worth
$39.99.

Windows Explorer

Keep forgetting what buttons on your toolbar do? Add text to them. Right-
click on your toolbar and choose Customize. In the drop-down box that says
Text Options, choose Show Text Labels.

1The Google Toolbar was really cool in 2006, but now that every browser has built-in
search, it’s not really necessary.
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WINDOWS XP BUG ALERT: When you change these, you may end up
changing Internet Explorer too. There is no way to get around this except
switching to Firefox.

General Windows

The Print Screen key is handy (take a screenshot and copy to the Clipboard),
but sometimes you have to crop it because the picture wouldn’t look good
otherwise (or maybe you just don’t want people to see your cluttered desk-
top). You can prevent the need to do this by pressing Alt-Print Screen. This
will take just the currently selected window.

StatBar

StatBar can be changed to sit directly above your taskbar, though I don’t like
the look of it. Right-click on the StatBar, er, bar. Choose Window Position,
Bottom. You’re done.

Crazy Computers

Okay, some people don’t know about the inner workings of PowerPoint, but
seriously, how many PowerPoint users are there out there that don’t know
about this “feature”? What will Microsoft think of next? Computers that
remind us that we can close programs with the X in the upper-right corner?2

2I must admit, five years later, this one still makes me laugh. Most of my Crazy
Computers columns seem like pointless ranting to me now, but this one continues to
totally baffle me. What on earth was Microsoft thinking?



5: July 2006

Microsoft Word

Save time with a nearly undocumented toolbar

If you spend any time at all making tables in Word, you will love the Tables
toolbar. This toolbar can go anywhere and makes creating tables and borders
easy. To get started, right-click on the File menu, then check Tables and
Borders. A new toolbar will appear. Move it to wherever you want.

The Tables toolbar makes no provision for a normal table, but it provides
lots of ways to manipulate one that already exists. All the buttons towards
the right of the toolbar (which are grayed out unless you’ve selected a table)
are handy buttons that perform tasks that would normally necessitate going
to the Table menu.1

Web Development: Notepad or Word?

That’s a simple question and answer: neither. WordPad, a word processor
that comes with Windows, is great for HTML editing. If you’re curious, ask
Soren.2

Windows Explorer

Views are important

1Originally there was a table of the functions of each button here. If you still use Word
2003, where there is a Tables toolbar that you might want to use, you can probably figure
it out yourself.

2Well, not many people do HTML editing in a text editor anymore. And I wouldn’t
recommend WordPad (or Notepad or Word) to do it.

27
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Okay, some people might say this isn’t a tip, but the Details view is often
the best view to use in Windows Explorer.

Bonus Tip: If you switch to Details View, you can add more details. Right-
click the little bar at the top that shows the categories, and choose More.
Check or uncheck the boxes to choose what you want on your details bar (you
have to set the current folder’s view as the default for this to show in all
folders).

General Windows

Function keys can come in handy. They are at the top of your keyboard and
are labeled Fx, where the x stands for a number from 1 to 12. Windows Tips
will review function keys and their uses.

Function Key Reference

These keys often go unused but are handy shortcuts

� F1 – Don’t you know? 99% of the time you can get help by pressing
F1.

� F5 – This keystroke usually tells a program to go out to your hard
drive, the Web, etc. to get a new version. In Word, F5 brings up
Find/Replace/Go To.3

Crazy Computers

Computers think they’re smarter than we are

So sorry, Norton AntiVirus, but I don’t want you to start scanning all five
gazillion bytes of my hard drive while I’m playing memory-intensive games.
I don’t want Office adding bullet points to my documents when I’m trying
to type three asterisks. Nor do I want Windows Explorer trying to use its
feeble “system file protection” that prevents you from seeing folders and files
that you occasionally need to mess with.

3There are more shortcuts in this column in a later edition—check the index.
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I wish that Norton would be smart enough not to scan your drive when
it’s clear that you’re busy (or not try at all), that Office would not try to
convert my typing to fancy-looking characters, and that Windows Explorer
would turn that silly file protection off. I think the message “These Files
Are Hidden. This Folder Contains Files that Keep Your System Working
Properly” has stopped about 5 people from looking at their system folders.
Who exactly does Microsoft think they’re going to “protect”?

Sure, fixing Norton perfectly would be hard, but it would be easy to not
make it schedule an automatic scan and instead notify you when it was time
to scan. Fixing Word would be easy: just stop fancy conversions. Maybe
provide a way to turn them back on, too. As for “system file protection”, it
should be banished from the face of the earth. How about letting us see file
extensions and hidden files while they’re at it too, huh?4 Microsoft is just
too stubborn. It has been proven in real-life tests that having file extensions
showing helps prevent viruses. And having them hidden can be confusing
because Windows only hides registered filename extensions.

The Clippit Column

Stop Clippit from talking to you automatically

Clippit may be annoying, but he can occasionally find topics that normal
Help just won’t find. But what about annoying “Do you want help with
this feature?” messages? And what about the infamous “It looks like you’re
writing a letter” message? In many cases, the best thing to do is prevent
Clippit from coming up until you tell him to.

To do this, bring up Clippit by pressing F1 in Word, right-click on him,
choose Options, and uncheck all the boxes. Close Clippit (right-click him and
choose Hide Assistant), then restart Word. Clippit won’t come to see you
until you ask him to. For more details on disabling Clippit, see Computer
Central News.

4Microsoft still has yet to fix this problem (and I refuse to call it anything but a
problem). Incidentally, if you don’t know about file extensions, please open Windows
Explorer, press the Alt key, select Tools → Options → Folder Options → View, and turn
off “Hide extensions for known file types.” Although the chance of getting an email virus
this way is lower nowadays, not having file extensions visible to the user is just stupid.
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NOTICES

Windows Tips is NOT just for Windows XP! For the purposes of Windows
Tips, I assume that you are running at least Word 97, Firefox 1.5, IE 6.0, and
Windows ME5, but many of the tips given here will work on earlier versions
of Windows.

If anyone has a tip that they would like published, please let me know!
I welcome these, and they will help the Windows Tips Club grow. Please
email me at sobjornstad@hotmail.com. Feel free to email me about the
newsletter and/or your tips. Your tip will be published on the Windows
Tips Club website. Windows Tips Club is up and running. With only two
members so far, there isn’t all that much there! Members receive the pass-
word to Windows Tips Club website and are able to have their tips and
email addresses posted there. They also have access to the Best Tips In The
Universe area. Members also will have access to any previous Windows Tips
newsletter, whether in the archive center or not, in full .doc format (or .rtf,
if you prefer), directly emailed from Soren. Please do not email me at any
of my “normal” addresses. Instead, please send all mail related to Windows
Tips to sobjornstad@hotmail.com, my new address for Windows Tips. I will
check it as soon as I can.

To get into the Windows Tips Club, one of Soren’s tips must have rev-
olutionized your work. Send a screenshot of your workspace with the tip
you are using for entrance. To take a screenshot, press the Print Screen key.
To get the picture saved, open Windows Paint (Start > [All] Programs >
Accessories > Paint), then press Ctrl-V and save the picture.

For more programs, advice, work aids, and the latest news in comput-
ers, visit Computer Central at http://home.comcast.net/~sobjornstad/

computercentral.

Thanks to all for their support of Windows Tips.
Tip: When it’s cold, wear a coat.

5Hah! The Mistake Edition!

sobjornstad@hotmail.com
http://home.comcast.net/~sobjornstad/computercentral.
http://home.comcast.net/~sobjornstad/computercentral.


6: August 2006

Microsoft Word

Remove buttons from the toolbar that you never use

Do you have buttons on the toolbar that you never use? Me too. Help
button, anyone? How about Decrease Indent? How about the little para-
graph marker, which turns on the so-called “feature” that makes the text
harder to read? Okay, maybe some people would disagree about the last
one. But you get the point.

You can remove these buttons if you want, and it doesn’t take too much
work. Choose Tools > Customize. Ignoring the dialog box that appears,
right-click each button that you want to remove and choose Delete.

Firefox

Firefox can’t be super-secure. It gets updates all the time. If you don’t have
at least Firefox 1.5 (Help > About), go update it right now. (Version 1.5
and later automatically update themselves.)

Web Development: Notepad or Word?

True, but there’s an even better program: EditPad Lite. I got the version on
my fancy new U3 flash drive, but there must be an ordinary version sitting
around. Even if you don’t plan to use it for web development, it’s a much
better text editor than Notepad.

31
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Windows Explorer

Add cut and paste buttons to your toolbar.

Use cut and paste in Windows Explorer a lot? Add Cut, Copy, and Paste
items to the Windows Explorer toolbar. Press Windows + E to open Win-
dows Explorer, right-click the Up button and choose Customize. Find Cut
on the list and click the Add button. Repeat for Copy and Paste.

General Windows

The desktop is generally not a good place to store things permanently. Two
better places to put things are on the Quick Launch toolbar and the Start
menu.

Crazy Computers

Computers need constant troubleshooting

Computers crash. There seems to be no way around it. Microsoft does a lot to
hide the fact, including claiming Windows XP doesn’t have a Blue Screen of
Death, making all their error messages cryptic, calling BSODs “Stop errors”
and creating messages such as “Internet Explorer has encountered a problem
and needs to close. We are sorry for the inconvenience.”

I wish Windows didn’t have the Blue Screen of Death, but lying to its
customers about stability is quite another thing. And what about Microsoft
making a bad decision that could cause your computer to go into an endless
loop while starting? (The option in question is “Automatically restart”,
which causes Windows to restart whenever it encounters a BSOD.)

The Clippit Column

Office 2007 is (finally!) removing Clippit completely. Makes me wonder if
they’ll release an addon (or a patch) that puts Clippit back in.
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Microsoft Word

Use macros to automate common tasks

Do you perform the same actions in Word over and over again? Are you
getting tired of clicking? How about trying macros?

Macros are simply miniature programs that replay your actions. No,
you don’t have to program anything to create one. The little strip at the
very bottom of Word that starts out with Page 1 Sec 1. . . is the status bar.
Anyway, double-click the little grayed-out REC button on the status bar. Fill
out the quick dialog box (no spaces allowed in the Macro Name) and click
Toolbars or Keyboard, depending on how you want the macro activated.

If you click Toolbars (hmm. . . looks familiar if you used the August tip)
drag the macro to a toolbar or onto a place on a menu. To open the menu,
simply drag over it.

If you chose Keyboard, click in the Enter Shortcut Key box (I think
it should have been Key Shortcut Key). Key the key combination (sorry
about nonsensical directions) and Word will tell you underneath whether it
is assigned. If it is, press Backspace and try another one. You may have the
most luck with Alt. . . key combos, but some Ctrl-Shift’s are unassigned.

After this is done, simply perform the actions you want recorded. When
you’re done, click the square button on the little box that popped up. To
run your macro, click its button or menu item or press the key combination.

Firefox

Yay! Firefox 2.0 is out! Don’t know much about it yet, though. Update in
the next newsletter.
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Windows Explorer

Rename your hard drive

Tired of going through life with a hard drive named “Local Disk”, “HP PAVILION
(C)”, or something similar? Fix it with a simple menu option. Open Win-
dows Explorer to My Computer, right-click on your hard drive’s icon, and
choose Properties. On the General tab, change the name in the box.

General Windows

You’ve got a very important tip. (Cryptic Code #24111)1

Crazy Computers

Computers say nonsensical things

When I accidentally leave a floppy disk in the drive and I shut down,
the next morning I turn on my computer. I walk off to do something else
while the computer loads. Five minutes later I come back and face a black
screen with the words Non-System Disk Or Disk Error / Remove and Strike
Any Key When Ready. First of all, what is a Non-System Disk? And what
is a Disk Error? Turns out the Non-System Disk dates back to the days of
DOS 1.0, when some people kept their versions on a floppy disk and used
it to boot their computer. (Apple II, anyone?) If you had the wrong disk,
the computer would tell you. A Disk Error apparently means the disk is
corrupted.

Then Strike Any Key. (Want me to destroy your keyboard, anyone?)
Why can’t it just say Press Any Key, like anyone human? And why can’t
the computer, when it sees that the floppy disk drive has a Non-System Disk
In It, go looking in the CD drive and hard drive for an operating system?

1Sorry, I have no clue what the heck this was supposed to mean. I’m curious too.
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I know I have already said this many times, but if you are in the Windows
Tips Club. . .

I WANT YOUR TIPS!
You might say you have none, but everyone has something they can con-

tribute. If you are not in the club, you can follow the steps at bottom to
join. 1

Microsoft Word

Stop personalized menus

Have you been thinking about upgrading to a new version of Word?
What’s held you back? Cost. . . or is it having to learn a new product, recon-
figuration, and annoying “features” such as “personalized menus”?

To turn off personalized menus, go to Tools>Customize and check Always
Show Full Menus.

Firefox

Sorry I have no update. I haven’t installed 2.0 yet. I’m apparently just too
lazy to DOUBLE-CLICK A FILE! It’s even sitting on my desktop.2

1In the original, these lines appeared in massive bold font.
2Didn’t it take about the same amount of time to write this column?
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Windows Explorer

Faster use of Details view

Details view is great, but when there’s a filename or other data that doesn’t
fit into a column, it gets annoying. Next time you run into this, double-click
the right boundary of the column in question. It will automatically resize.

FYI: This also works with Excel.

General Windows

Lost the Show Desktop icon? Unfortunately, it is rather difficult to get back.
Pull up Notepad (Start > [All] Programs > Accessories > Notepad) and type
the following precisely:

[Shell]

Command=2

IconFile=explorer.exe,3

[Taskbar]

Command=ToggleDesktop

Now save the file as Show Desktop.scf and put it on your Quick Launch
toolbar. Hmm. . . looks a lot like your original icon!

Function Key Reference

These keys often go unused but are handy shortcuts

� F1 – Don’t you know? 99.9999999999999% of the time you can get
help by pressing F1.

� Alt + F4 – This keystroke closes the active program. If you are on
your desktop, it brings up Shut Down.

� F5 – This keystroke usually tells a program to go out to your hard
drive, the Web, etc. to get a new version. In Word, F5 brings up
Find/Replace/Go To.
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� F7 – In Word, F7 does a spell check. Pressing Alt-F7 checks the closest
word and displays a popup menu with results.

� F12 – Ctrl+S in Word comes in real handy. What about a Save As
shortcut key? F12 does just that.

The Escape Key- One Million Uses

I think the Escape key is one of the neatest keys on the keyboard. Nobody
uses it because
a) it is on the keyboard and
b) nobody knows about its uses

Therefore, I will tell you some uses, one a month. I don’t know nearly all
of them, so look on!

Each month’s current tip will be labeled in bold.
The Escape key is often labeled Esc, and is ALWAYS in the upper-left

corner of the keyboard. If your keyboard has shortcut buttons, the Escape key
will be below them.

� To escape from Menuland: If your keyboard doesn’t seem to work, you
may be caught in Menuland. Press Esc to leave.

� Close unwanted dialog boxes: If you accidentally open a box such as
Open, just press Esc to leave.

� Stop loading a page in IE, Firefox, Mozilla, Netscape, or just about
any other browser you can think of: If you accidentally click a link,
just press Esc to stop it loading.

� If you can’t get to your taskbar and you can’t find your Windows key:
Press Ctrl-Esc to show your taskbar and open your Start menu.

� You probably know about Ctrl-Alt-Delete. Introducing Ctrl-Shift-Esc!
Ctrl-Shift-Esc also brings up the Windows Task Manager, but if you
are on a large network (domain), then you probably know that you
normally have to click Task Manager after pressing Ctrl-Alt-Delete.
Ctrl-Shift-Esc eliminates this step.
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� If you are playing one of the Windows games and your boss walks in:
press Esc to minimize it instantly. Note that this doesn’t work on all
of them.

� Running an ancient DOS program with DOSBox or something similar
that runs fullscreen. You stuck in it? Hit Esc and see if it helps.

� If you start dragging a file and then change your mind, just
press Esc before you let go of the mouse button.

Crazy Computers

Crazy, means-nothing “Warnings” in Event Viewer

Wow! How awful! We couldn’t synchronize the clock in an astronomically
long 13 Hours! We’re Unsynchronized!

Computers often display stupid messages like this when you look deeper.
Unfortunately, there’s really no way to get rid of them. You just have to deal
with it—and have a little laugh when something like this shows up.

OH NO! I’m Unsynchronized about a tenth of a millisecond!!!
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The Clippit Column

Is Clippit staring blankly at you? Right-click him and choose Animate.
You’ll have to do it a few times, but there’s a bunch of cool ones.
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Part II

Technical Geekery Tips
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Note to Receivees

This newsletter will replace Windows Tips, which many of you will have
received. I decided it was time to fix up the whole setup, plus people always
like something new. If you read Windows Tips, you will find that this is very
similar, with the elimination of several features such as Crazy Computers.
Those features will hopefully soon be available through the Technical Geekery
website.

Microsoft Word

Heard about the new version of Word? Had enough with your version? Well,
you need to do some considering before you try it.

First of all, if you have Office XP (2002) or later, you aren’t going to get
much new. For a $150+ product (and that’s a cheaper price), it’s often not
worth it. Plus, you have to learn a new interface. Office 2007 now does not
have a menu bar. Instead, you must access all features from the 2-inch-thick
tabbed bar at the top called the ribbon.

Which brings us to the tip. The thing that Microsoft did do to help people
in transition was to include all of the old keyboard shortcuts. If you know
the system that’s been in Windows for hundreds of years (in computer time),
this could be a help. This system involves pushing Alt and then underlined
letters on the menu bar. Although you can no longer see the menus, you can
still use this shortcut.
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Internet Explorer

So you went ahead and downloaded IE 7 or maybe it came with your com-
puter. But other than the tabs, there doesn’t look like much new. In fact,
Microsoft made quite a few significant changes. The tip for this month in-
volves tabs. Have you ever noticed the funky icon to the left of the tabs that
looks like four squares making a square? That is actually a new and quite
flashy, if not hugely useful, feature. But even though it seems more for looks,
it can help your browsing if you have lots of tabs (like I always do). Clicking
it will show a page with a thumbnail of each tab along with the name.

Firefox

Simple this month, but important. If you don’t have version 2 yet, GET IT!

Windows

Thinking about upgrading to Vista? Stop a moment and think. If you are
buying a new computer, there’s nothing stopping you from getting it instead
of trying to get one with Windows XP on it. However, upgrading to it does
not have enough benefits to justify the $400 price tag (for Vista Ultimate)
or more like $200 (for Home Premium). Among the new features are better
graphics (which can actually help your work if set up properly) and a good
search.

Announcements

Well, short enough? But seriously, there may be some programs you would
love to have tips for. Send me an email at soren.bjornstad@gmail.com and
tell me what program you want included. Sorry, but there are no guarantees
that it will be. Thank you for your support. If you ever want to unsubscribe,
just let me know.

soren.bjornstad@gmail.com
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Microsoft Word

Do you have text in Word that you seem to do over and over again? Well, a
very easy feature to figure out in Word (any version up to 2003 and [possibly]
beyond) can help you out.

To use this feature, go to Tools>Macro>Record New Macro. Name it if
you want, then click Keyboard to assign your macro a keyboard shortcut.
Type a keystroke into the box. If it is assigned already, Word tells you. Press
Backspace and try again. When you are happy with your keyboard shortcut,
press OK. Click Assign, then Close. Your mouse cursor will have a tape
icon next to it and a small box marked Macro Recording will appear. Type
the text you want inserted. When you’re done, click the square on the little
Macro Recording box. You can now press the keystroke to type your text.

Internet Explorer

If you’ve been following, you’ll know that the little four squares icon to the
left of your tabs opens a thumbnail window. But what if you know what
tab you want but can’t find it? Click the little down arrow next to the four
squares. A dropdown list of your tabs will appear.

Firefox

If you’re a Firefox user, you might often get annoyed with its slow loading
time. Much of the time, you just want to have a browser load fast and you
plan on closing it right away.

Anyone out there remember Netscape? Well, there’s a new incarnation
of that, now completely open-source. It’s called SeaMonkey. Download it at
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http://www.seamonkey-project.org. You can still use Firefox, and it’s a
small, fast browser. A feature that’s not immediately obvious is that it does
support tabs. To show the tab bar, press Ctrl-T.

Windows

Ctrl-Alt-Delete is a well-known keystroke. But it can be annoying that it
takes both hands. You can technically use Ctrl-Alt-Delete with one hand if
you twist your hand in a very awkward way. But a much easier way is to
press Ctrl-Shift-Esc. Hold Ctrl-Shift with your thumb and index finger, then
push Esc with your middle finger. Although it takes a while to relearn it,
doing things this way tends to be easier, especially if you have your hand on
the mouse.

Networking/Internet

Ever wonder if you’re really disconnected from the internet or your connec-
tion/cache/etc is just screwed up? Well, there’s an easy way to find out.

Go to Start>Run (or press Windows-R) and type cmd /k ping www.google.com.
If you don’t get messages starting with Reply From, then you aren’t con-
nected.

If this command seems too hard to remember, follow this link and down-
load my program.1 Open the zip file and run the program inside. Thereafter
you can choose Start > Run and type interneton to run this command.

Announcements

Well, short enough? But seriously, there may be some programs you would
love to have tips for. Send me an email at soren.bjornstad@gmail.com and
tell me what program you want included. Sorry, but there are no guarantees
that it will be. Thank you for your support. If you want to unsubscribe,
email me at the above address.

1This program isn’t terribly useful, and I don’t know where it is anymore. So there’s
no link.

http://www.seamonkey-project.org
soren.bjornstad@gmail.com
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Microsoft Word

Zap Clippy!
Do you still have Word 2002, 2003, or an even earlier version? Yeah,

me too. What do you think is the number-one annoyance that was resolved
in Office 2007? (“It looks like you’re writing a letter. . . ”) You guessed it.
Clippy. Well, believe it or not, there is a pretty easy way to turn him off.
Choose Help>Show the Office Assistant one last time. Right-click Clippy
(or whatever character you may have chosen) and choose Options. Uncheck
every box on this page, including (if you have it) Use the Office Assistant.
Click OK. Just don’t go to Help>Show the Office Assistant again, okay?

Internet Explorer

If you just switched to IE 7, you might be annoyed at the loss of the menu
bar. Although all its functions are available elsewhere, it is often the easiest
way to do something. If you just need to see it for a second, you can push
the Alt key and it will appear. (By the way, that trick works for just about
any Vista [or XP] app without a visible menu bar.)

But if you use it often, you should consider showing it. To enable using
the menu bar, you need to use—you guessed it—the menu bar. In Internet
Explorer, push Alt, then choose View>Toolbars>Menu Bar.

Firefox

Have you ever noticed the Links toolbar? It can look a bit annoying, but
once you get used to it, it can be rather helpful for some people. If you’re
not sure what the Links toolbar is or if you have it enabled, look under the
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Back button. If you see a Latest Headlines button, it’s working. (If you’ve
installed a toolbar [or it came with your computer or another app] such as
Google or Yahoo, you may need to look under that.) To add something to
this toolbar, find the little icon to the left of the URL and drag it to the
toolbar.

Windows

What really changed in Vista?
This article will be slightly long this month, owing to the length of the

topic. Please feel free to skip parts of it if you don’t think they apply to
you, but if it interests you, I encourage you to read because you may learn
something new.

Below I will talk about what the changes are. I will explain all the
features, then supply another paragraph or two talking about differences
between versions.

Interface

Yes, the new “Aero” interface seems more like a marketing feature for people
who just go by looks. But it can truly be helpful to you. One thing is that
you can see under the title bar of any window. With certain windows, there
may be a larger transparent portion. (See Screenshot 2.)1 Another lesser-
known fact is that you can see a preview of a window by hovering the mouse
over the taskbar button (Screenshot 3). Probably the most fancy feature that
Microsoft used for marketing is called Windows Flip. You’ve probably heard
of it. Use Screenshot 4 to confirm your suspicions. I like to call it “Twirly
Window.” To get this, push Windows-Tab. Continue pushing Tab until the
window you want is in the front. The desktop is also a choice. If you can’t
figure out what a window is, you can try Alt-Tab, which also shows the name
of the window as well as a thumbnail preview. You may have to switch back
and forth. Alt-Tab is shown in Screenshot 5. (Incidentally, Alt-Tab with a
much less fancy interface was available in earlier versions of Windows back
to Windows 95.) As you can see, transparency is widely used in all these
features.

1I left out the screenshots. If you’d like to see them, you can view the article online at
http://thetechnicalgeekery.com/windows/archives/tips_2008.03.pdf.

http://thetechnicalgeekery.com/windows/archives/tips_2008.03.pdf
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Start menu

Yes, the new Start menu has several new features, but you can probably live
without it. To check it out, see Screenshot 6. The most notable change is
that there is now a search box (which can be activated by simply typing,
no need to click in it) meaning that searches are much easier. This same
box is also found in every Windows Explorer window. The icon at the top
of the Start menu shows your user picture. However, when you mouse over
an option on the right side of the Start menu, it changes to show the icon
for that folder or option. The big power button now activates “Turn Off”
mode, which saves the hard drive’s contents to disk and switches to low power
mode. This means that if the power goes out, you won’t lose any data. To
shut down, click the little arrow to the right of the two power buttons.

Other changes include that All Programs now changes the Frequently
Used Programs and Pinned Items lists to All Programs rather than opening
a little flip-out menu (no, that’s not the official name) and the absence of a
Run button.

Windows Explorer

Several features in Windows Explorer may greatly help those of us with many
files (such as a certain webmaster and newsletter writer in Valparaiso). See
Screenshot 7 to take a look at my Documents (yes, the My finally got omitted)
folder without any sort techniques.

Although the distinctions can get extremely confusing at times, there
are four sorting techniques: sorting, filtering, grouping, and stacking. Both
sorting and grouping (in a limited form) were available in Windows XP.
Sorting is the simple, old way to organize files, simply organizing files by one
of the columns you click at the top (see Screenshot 8). I sorted by Type
in this example. If you don’t see columns at the top of the window, choose
Views and drag the slider to Details. To sort, you can simply click a column.
To reverse the order, click it again. The default sort is ascending by name.

Filtering is nearly as simple, but is a totally new feature. It takes sorting
to a new level by blocking out the files that are not of a specific type that
you select. On a technical level, filtering uses the search engine, so, unlike
with grouping and sorting, filters you set will not still be there when you go
back to the folder later. As evidence of this, you may see a message at the
bottom of the screen saying Did You Find What You Were Searching For?
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Unlike with grouping, stacking, and sorting, you can filter by more than one
category. Filtering is done by clicking the drop-down arrow next to a column.
This arrow only appears when you mouse over the column. A filtered column
displays a check mark next to it. To learn about filtering, see Screenshots 9
and 10.

Grouping is like in Windows XP. To group, right-click the window and
choose Group By>Whatever Category You Want To Group By. If there’s
too much on the screen, you can click the little up arrow at the right of the
heading. See Screenshot 11 to learn about grouping.

Finally, stacking is basically a different way to use search. If you’ve ever
used Google Directory (http://directory.google.com) you know what I mean.
Great site, by the way. Stacking sorts all the files and folders in the current
folder and subfolders and provides them for you to pick one. It can be helpful
if you don’t want to group things but don’t want to use the search either.
It’s also just a cool new feature. See Screenshot 12 to get an example of
stacking. To view one of these searches (“folders”), just double-click it.

The other new feature of Windows Explorer saves copies of your files
and allows you to restore an old one if something goes haywire. This is not
available in all versions, but if you have it, it can be really useful. To access
these versions, open the Properties dialog box for the file by right-clicking
and choosing Properties. Then choose Previous Versions.

There are other improvements in Vista, but I am not trying to write a
book or even an essay on the topic. If you want to learn more about the
new features and basic functions of Vista, I highly recommend picking up a
copy of Windows Vista All-In-One Desk Reference for Dummies by Woody
Leonard. This book has been highly useful to me in making the transition
to Vista and learning about the differences.

Version Differences

This maybe shouldn’t come after a paragraph that seems to end this article,
but I figured it should be last. There are, unbelievably, eight versions of
Vista, and all of them are designed to make Microsoft money, save Microsoft
money, or stop a lawsuit. Don’t get tricked into buying the wrong one for
stupid reasons.

� Vista Home Basic is very cheap but doesn’t provide many features
that people like about Vista. Previous Versions, the Aero interface,
and several video tools are the main items left out.
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� Vista Home Premium is also relatively cheap but doesn’t leave out
nearly as much. The only big thing that is left out is Previous Versions.

� Vista Business is for business users and generally should not be bought
by home users. Video tools are left out.

� Vista Enterprise is for big businesses and includes everything in Busi-
ness plus tools to connect the computer to a corporate network. It can
only be rented, five copies at least.

� Vista Ultimate includes everything in all versions but tends to be very
expensive.

� Windows Starter 2007 is not available in the US. It was designed to
reduce software piracy by making a cheap version of Vista available in
developing countries, but it has extremely few features.

� Vista Home N is like Home Basic, except it doesn’t have Media Player.
This had to be included because of lawsuits long ago. Totally goofy.
There’s no possible reason you would want it.

� Vista Business N is like Business, except it does not include Media
Player. As one of my favorite books says, “Goofy with a tie.”

Announcements

There may be some programs you would love to have tips for. Send me an
email at soren.bjornstad@gmail.com and tell me what program you want
included. Sorry, but there are no guarantees that it will be. Thank you for
your support. If you want to unsubscribe, email me at the above address.

soren.bjornstad@gmail.com
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Microsoft Word

Use the Work menu

Do you use the documents at the bottom of the File menu to get to recently
edited documents? Many of you will know that it sometimes doesn’t go back
far enough. Although you can increase the number of documents that are
stored there, there is a better way. You can easily create a menu that shows
the documents you choose to put on it. These steps are pretty simple, but
follow along carefully or you might accidentally change something that would
not be as simple to change back. (One time I accidentally deleted the menu
item that allows you to change menu items.)

To create the Work menu, choose Tools>Customize and click the Com-
mands tab. On the left side, scroll all the way down and click Built-in Menus.
Scroll down on the right to Work and drag it next to Help on the menu bar.
Close the Customize dialog box.

From now on, you can choose Work>Add to Work menu to add a docu-
ment you have open. To open one of the documents on the list, simply click
its name.

Removing documents from the list is not quite as easy. Don’t lose this
file if you use this tip, because you might need to refer to it in order to delete
an item. (If you do, I posted it on the Technical Geekery website as well.)
To begin, push Ctrl-Alt-Hyphen. You cannot use the one on the numeric
keypad; it has to be the one near the Backspace key. STOP. Do NOT click
anywhere except where directed because this technique can delete any menu
item, not just one on the Work menu. Your mouse pointer will have become
a big black hyphen. Now choose Work and click the document you wish to
remove. If your mouse pointer disappears, it’s because you moused outside
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of the Word window.
If you accidentally delete the Add to Work Menu item, shoot me an email

at soren.bjornstad@gmail.com. I hope it won’t happen to anyone, and I
don’t want to try it myself unless it’s necessary.

Internet Explorer

Have you noticed the little box next to the Address bar that says Google (or
Yahoo or Ask or Joe Bob’s Evil Flying Pig Finderer Discoverer Searchery
Thingy Search, depending on who paid your computer manufacturer) in it?
You can type in this box to search that place. For people who like keyboard
shortcuts, you can use Ctrl-E. (No, I don’t know why E stands for “Search.”)
Changing the provider is easy too, at least if you want to switch it to a
common provider. Click the little black arrow next to the magnifying glass
icon that sits in the Search box and choose your preferred provider.

Firefox

Do you notice those little lines in your Bookmarks list that look so fancy
and professional? Intended to divide different sets of bookmarks, these don’t
seem very easy to make. However, it’s surprisingly easy. Simply right-click
the entry below where you want the separator and choose Add Separator.

Windows Vista Report

Last month there was a report on what changed in Vista. Several months
ago there was a report advising you not to buy Vista by itself because it
wasn’t worth it. I still completely agree with this. I finally came up with a
simple set of rules.

� If Windows XP is still working just fine, there’s certainly no reason to
buy Vista.

� Unless you can’t live without one of the following features, you’re better
off staying with your old computer:

– Instant search in the Start menu

– Better backup and data recovery features

soren.bjornstad@gmail.com
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– Better sort in Windows Explorer

� If you aren’t a business, go with Vista Home Premium. Geeky types
might be tempted to buy Ultimate, but it isn’t worth another hundred
dollars.

� DON’T buy Vista Home Basic unless it’s not for your main computer.
You’ll regret it for a long time.

Prize coming. . .

One free email address, yourname@thetechnicalgeekery.com being given
away! All you need to do is find the formatting difference between two parts
of this document. They may even look the same. . . And no, it isn’t bullets,
bold, italics, underline, tabs, etc. First person to send an email to me with
the correct answer wins the address and configuration. It can be set to
automatically forward to another email account, too.

Announcements

What program do you not see on here that you use? Come on, you know
there are some. If I get the same program from at least two customers and
I know something about it, I will include it on the next newsletter. Do
you have any friends who you think would like this newsletter? Have them
send me an email at soren.bjornstad@gmail.com and ask to be added to my
mailing list. If you wish to unsubscribe, you can click the link in my email.

yourname@thetechnicalgeekery.com
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Internet Explorer

If you upgraded to IE 7, you might have trouble figuring out how to save
pages. Ctrl-S doesn’t work, and it is difficult to find the menu bar, especially
in Vista. (Incidentally, if you know where something is on the menus, you
can tap the Alt key to see them temporarily.) The new Microsoft-approved
way to save a webpage is to click the big Page button on the right side of
IE’s toolbar. Then choose Save As.

Firefox

I discovered this trick to be a great time-saver, a great time-waster, and a
great way to make things totally sloppy if you don’t clean up. If you use it
properly, it will do nothing but save time. If you are sloppy, it will cause you
to wait for about ten times the time it normally takes to load Firefox.

Anyway, this trick automatically saves all your open tabs when you close
Firefox. It will waste your time if you don’t ever bother closing tabs, however.
If you don’t think you will be disciplined enough to do it, this trick WILL
SLOW YOU DOWN. Anyway, to do it, simply choose Tools>Options. Select
the Main tab if it isn’t already, then at the top where it says Startup > When
Firefox Starts, select Show My Windows And Tabs From Last Time.

General Internet

I was a user of Yahoo Mail for nearly six years, and I always thought it was
great, especially after they added an interface that allowed you to drag stuff
around, show stuff in a preview pane, etc. But when Google announced that
Gmail was available to the public, I decided I might as well try it. After
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discovering the features and simplicity of the Gmail interface, I decided I
was going to switch.

It wasn’t an easy transition, but I made it and it was worth it. I’ve been
using it for nearly a year now and found it to be the best service I’ve ever
used, and I have used a lot. I have tried accessing it through desktop email
programs using IMAP (which is an option) but I decided in the end that the
web interface was the simplest.

How the Newsletter was Made: Useful Utilities

As you may know, creating PDF’s using Adobe’s software costs hundreds
of dollars a year, even for an individual. The only way to do it cheap is
with conversion software. I use a very nice program called DeskPDF. You
can right-click any convertible file and choose Convert with DeskPDF or you
can print anything to the DeskPDF printer. The best part? You can use it
a few times with no limitations, and then it only costs $20. You can also
purchase large numbers of licenses for a discount amount if you want to use
it in an office, for example. Go to http://www.docudesk.com/support_

files.shtml to download the trial version.

http://www.docudesk.com/support_files.shtml
http://www.docudesk.com/support_files.shtml
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Microsoft Word

I am definitely not trying to advertise anything for Microsoft in this article,
especially since I don’t like Office 2007 myself. However, there is a very good
addition to the grammar check in this version. It is capable of spotting things
that it thinks should be said some other way but are correct, such as words
that are spelled correctly but don’t make sense in the context. If it finds
such a sentence, it gets a blue underline.

This tip was drawn to my attention by Jennifer Bjornstad, one of my
longtime readers.

Internet Explorer

If you don’t have a good mouse, or are bad at moving it precisely, this tip
may be useful to you. You can get the buttons on the toolbar to expand and
give you a larger target with only a very small waste of space on the area
that displays the website. Right-click on a blank part of the toolbar (to the
right of where the tabs are is a good place) and choose Use Large Icons.

Firefox

Have you ever been to a website that seems to have the teeniest text ever?
Yeah, me too. It used to drive me crazy, until I discovered that there’s a really
easy way to zoom on a webpage. Simply press the key combination Ctrl-+
to zoom in. You can repeat this as many times as necessary to make the
text readable. If you really don’t like the keyboard or have your hand on the
mouse and are willing to move it a long way, you can also choose View>Text
Size>Increase. To return to normal size, push Ctrl-0. Note: Because of the
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way web pages are encoded, this trick cannot zoom on pictures.

Vista Report

Have you ever seen the fancy “Copying” dialog box for Vista? It looks sort
of neat, but it doesn’t show any more information than XP’s. But wait a
second-did you notice the little “More Information” button in the corner? If
you click this, you get all sorts of useful information, such as being able to
see the from and to folders without them being cut off, the copy speed in
megabytes per second, and the number of items remaining and their size.

General Internet

I always hate advertising for other companies. Even more, I hate making it
seem like I think my ideas are always the best ever. But even so, I will go
on with this article.

I have recently created a forum that allows people to post minor problems
with their computers that don’t require immediate action. This has three
advantages: one, it allows anyone to attempt to help you (and many people
have a better chance of answering than just one); two, it is simple to use;
and three, you don’t have to deal with calling somebody on the phone who
knows much more than you but thinks you are a total idiot.

Unfortunately, nobody seems to be using it (at least as of this writing).
So next time you have a small problem with your computer, I would greatly
encourage you to log on to my website, www.thetechnicalgeekery.com, click
the Forums link, and post your problem. To get an account (which shows
you what articles are new and allows you to post), click the Register link at
the top of the page. The signup takes about a minute, unless you actually
try to fill in all the blanks.1

1This forum doesn’t run anymore. I reran this plea in the newsletter about five times,
but nobody took me up on it.
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Microsoft Word

Do you want to open a document in Word and save it as another file but are
afraid that you will accidentally save over the original? Here’s an easy way
to prevent you from doing this. Start Word and choose File>Open. Find
the file you want, then click the little teeny arrow next to the Open button.
(See below if you aren’t sure.) Then choose Open As Copy. You can then
save it with another name (if you remember!)

Internet Explorer

Although this feature isn’t as useful as it is in Firefox, IE can read RSS
feeds, a sort of news updater thingy that allows you to read current content
quickly. When you browse to an RSS-enabled website, Internet Explorer’s
“green wave” icon lights up. To subscribe, you can click it. When the
resulting web page loads, choose Subscribe To This Feed at the top of the
page. You can now view it on the Feeds tab in your Favorites Center (the
star in the upper-left corner of IE.)

Firefox

Well, you can also read RSS feeds, just like IE users. But Firefox’s way is a
little bit simpler, in my opinion. To subscribe to a feed, go to the site that
provides the feed. When browsing to a site that supports RSS, an icon exactly
like IE’s will appear. However, it will appear at the right of the address bar
instead. When clicked, Firefox will display a page showing the contents of
the RSS feed (well, not exactly, but you can think of it that way). Make
sure that Live Bookmarks is selected (it’s the default) and choose Subscribe
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Now. Choose OK and your new feed should be shown as a Live Bookmark on
the Bookmarks toolbar. If you don’t have the Bookmarks toolbar enabled,
simply choose View>Toolbars>Bookmarks Toolbar.

New Way of Typing

Have you ever heard of the Dvorak keyboard layout? Well, most people
haven’t. It is a system that completely rearranges the keys into a more
logical layout than the more common QWERTY keyboard, which, after all,
was created to slow typists down (to stop typewriters from jamming). It
claims to be faster, more comfortable, easier, and much less likely to cause
injuries. I have already discovered that it is definitely more comfortable, but
I have not been using it for long enough to decide on a final review.

The preceding paragraph (but not this sentence) was typed using the
Dvorak layout, however, it took me 15 minutes to do because I have not
practiced that much yet.1

1Side note/evangelism/bragging: I can now type over 100 WPM on Dvorak. It’s defi-
nitely worth it.
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Microsoft Word

The tip for this week is tested on only Office 97-2003, but Office 2007 may
have a similar procedure. Do you have only a couple of commands that you
usually use in Word but are annoyed because they are buried? How about
creating your own custom toolbar?

Although it seems like this would be difficult, you can complete it in
about five minutes, most of which will be spent looking for commands to put
on the bar. To begin, choose Tools > Customize. Don’t forget that while
you are working you MUST leave this window open or you cannot modify
your toolbar. Once you have reached this window, choose the Toolbars tab
if it isn’t selected, click New, and then type a name for your toolbar. After
clicking OK, a teeny window with a blue title bar will appear.

Now go to the Commands tab. On the left, choose a category, many
of which will be familiar as the menus at the top of your screen. Then
find a command that you want on the right. Drag it to your toolbar and
keep looking for more commands. You can customize the appearance of each
command later. You will probably see many commands that you didn’t know
existed or you didn’t know could be placed on a toolbar, such as the Small
Caps button on mine. Once you have all the commands you want, you are
ready for the next step. As silly as it may seem, you must keep the Customize
window open even when you don’t need anything in it anymore. When you
close the window, all your toolbars are locked and cannot be modified until
you open it again.

Now you may want to change a few things. I like to have things labeled,
especially if they are new. If you want your buttons or at least some of
them labeled, right-click the target and choose Image and Text. You can
also change the name while you right-click an object. Simply fill in a new

63



64 16. AUGUST 2008

name. The & sign simply makes the next letter underlined, which allows
you to move to it by pressing Alt and then the underlined letter. If there is
another one with the same underlined letter (such as on a menu) then you
can toggle between them and press Enter when you reach the correct one.

When you are done with your customizations, drag the toolbar to its
final place. This can be at the top or bottom (or even in the middle of the
document or on the side). Then close the Customize dialog box. If you ever
want to modify the toolbar, simply click the little down arrow pointed to by
the arrow on the page (yes, confusing.) Then choose Add or Remove Buttons
> Customize. You will end up with the dialog box you were using earlier
and can right-click commands or drag new ones on.

Internet Explorer

You can change the search provider where IE goes when you type something
into the search box at the right of the address bar. Simply click the arrow to
the right of the magnifying glass and choose which one you want. For even
more, choose Find More Providers.

Firefox

Get Firefox 3 at www.firefox.com.

Windows

It may be that nobody has ever even thought about this, but having your
Windows version displayed in the corner of your desktop can be handy. This
tweak also displays the “Build” which is occasionally useful technical infor-
mation. It also looks a bit geeky, so don’t be surprised. This tweak seems
a little bit odd, but it is also quite simple and not dangerous compared to
other ways of getting this done.

To begin, start Notepad, which is usually under Start > All Programs >
Accessories > Notepad. If you can’t find it, simply press Windows (the flag
key) + R. Then type ‘notepad’ (without the single quotes) and push Enter.
Type the following into Notepad:

Windows Registry Editor Version 5.00

[HKEY_CURRENT_USER\Control Panel\Desktop]

"PaintDesktopVersion"=dword:00000001
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If you have done this tweak and wish to turn it off, you can replace the
final 1 with a 0. When you are done typing, save the file as “version.reg”.
Make sure to include the quotes this time. Then close Notepad and double-
click the file wherever you put it. If you are using Vista, you will have to
click through a security dialog box. Choose Yes in the resulting dialog box.
Click OK in the next dialog box. As soon as you restart your computer, you
will see the change.
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Microsoft Word

Do you ever have zillions of documents open in Word? I sure do, and going
through each to save it after editing all over them sure gets annoying. That’s
why I use a hidden way of saving all open documents at once. It’s really
simple once you know the trick. Hold down the Shift key while clicking File.
The Save option will change to Save All, with a pile of disks as the icon. The
next time you go up to the File menu, it will go back to normal. Note: If
you use Office 2007, I would assume you could hold Shift while hitting the
Office Button, but I haven’t tried it.

Internet Explorer

Are you browsing on a small screen and tired of all the junk cluttering up
the screen? Simply press F11 while in the browser and the browser will
fullscreen. If you move your mouse away from the top of the screen, the
navigation bar will disappear. Simply move the mouse to the top to see it
again.

Firefox

Hey, guess what? You can also browse full screen. It works exactly the same
as in IE.

Windows

How would you like to change a folder’s icon so that you can pick it out
easily? Well, now you can, if you have Windows XP or Vista, and in just a
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few seconds. Simply right-click the folder and choose Properties. Click the
Customize tab at the top and choose Change Icon. You have a good number
of icons displayed immediately, but you can get even more. Try typing the
following into the Look For Icons In This File box at the top:

� Shell32.dll (default)

� Moricons.dll (old programs, especially notable for the great file cabinet
picture toward the end of the listing)

� Progman.exe (XP ONLY, all sorts of stuff)

� Syncui.dll (folders)

� Pifmgr.dll (brightly colored household objects)

� User32.dll (error, info, etc. icons as displayed throughout Windows)

� Explorer.exe (seemingly random)

� Dialer.exe (phones)

� Regedit.exe (weird cubes)

� Taskmgr.exe (variously filled status bar-thingies)

� bthprops.cpl (possibly Vista only, random again)
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Microsoft Word

Do you know all the key combinations for Word? No, you don’t. Word
has many great shortcuts using the “function keys” (you know, the F-keys).
However, they are nearly impossible to remember or learn without a piece of
paper. (Is this the 21st century?) Fortunately, you can get yourself a cheat
sheet. Just choose Tools > Customize > Toolbars and select the Function
Key Display checkbox. Another toolbar will appear, which you can drag
anywhere. The display changes when you press Ctrl, Shift, or Alt to show
the new commands available.

Internet Explorer

Can’t find an IE shortcut anywhere? Want a faster way to access it? Simply
choose Start > Run or type Windows (flag key)-R and type iexplore.

Firefox

You can also get a quick type launch for Firefox. Choose Start > Run and
type firefox.

Windows Key

Have you ever wondered what the flag (Windows) key on your keyboard was
for? It’s usually between the Ctrl and Alt keys, although it’s at the top on
some laptops. No doubt you have accidentally discovered that pressing it
opens the Start menu. But you probably don’t know about the following
timesaving shortcuts:
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� Windows-F [opens a Find window]

� Windows-E [starts Windows Explorer centered on My Computer]

� Windows-D [minimizes everything, press again to go back]

� Windows-M [minimizes all windows except dialog boxes, press WindowsShift-
M to go back]

� Windows-Break (yes, that’s a key, look for it) [opens the System Prop-
erties dialog box]

General Windows

Have you ever been in need of some background music say, for a presentation?
Were you on a computer without any music on it? Well, every Windows XP
or later computer has three quite good background music MIDI files on it,
which can be opened in Windows Media Player. Simply choose Start >
Run and type C:\Windows\Media. The three files are called flourish.mid,
onestop.mid, and town.mid. The best way to get a feel for them is simply to
try them out sometime and see what they’re like.
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Microsoft Word

Did you just type a couple of sentences with Caps Lock on accidentally?
Guess what—you don’t have to type it all over again. Just remember the
magic shortcut Shift-F3: push it to toggle between UPPERCASE, lowercase,
and Title Case. If you want to prevent the problem from happening at all,
see Keyboard Shortcuts this month.

Firefox

Want to get lots of fun but useless (okay, maybe a few useful) add-ons for
Firefox? Simply open Firefox. In the following directions, you may need to
replace the word “extensions” with “add-ons” depending on your version of
Firefox. Choose Tools → Extensions, then in the corner click the Get More
Extensions link and browse the resulting site for handy or useless gadgets.

Google Chrome

Google released a browser. How can anyone not have heard about it? Google
Chrome offers some pretty interesting new features and runs and loads very
quickly. Beware about running Flash animations and games, though: Google
Chrome doesn’t run very fast on them, although the Googlies are working
on it, so it will hopefully be revised soon.1

Go to http://www.google.com/chrome to download your free copy.

1Lately I haven’t seen any problems with this anymore.

71

http://www.google.com/chrome


72 19. NOVEMBER 2008

Keyboard Shortcuts

There are lots of interesting “accessibility” keyboard shortcuts for Windows.
Although many of them are not likely to be useful unless you have some
specific need, some are great for just about everyone.

Do you ever turn on Caps Lock accidentally? If you’re like most people I
know, you do so quite a bit—and it’s quite frustrating to have to type it over.
(Well, you can also select it and choose Format → Change Case in Word,
but that’s stupid.) Simply hold down your Num Lock key for a few seconds.
You should get a dialog box telling you about “ToggleKeys”. If nothing
happens, just try again; Windows seems to have a tendency for swallowing
accessibility keyboard shortcuts at random. Click OK in the resulting dialog,
and the change will be made permanent. From now on, if you push the Num
Lock, Caps Lock, or Scroll Lock key, your computer’s internal speaker will
sound to inform you. If you need to turn this off, simply repeat the process;
there is no confirmation except a weird downward scale sound and the fact
that pushing one of these keys no longer causes a tone.

Also see the Microsoft Word tip if you just want to change a bunch of
text you typed in with the wrong case.
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Microsoft Word

If you’re unlucky enough to still have a version with Clippy enabled, here’s
two easy ways to zap the annoyance once and for all. (Note: if you have Office
2007, Microsoft finally removed Clippy completely and spared Windows users
the world over the annoyance. I just wish they had quit when they were
ahead: what’s up with the menuless design?)

If you’re like me and sometimes enjoy watching Clippy do weird anima-
tions or something similar but absolutely detest annoying popups like “It
looks like you’re writing a letter”, try this fix. Choose Help → Show the Of-
fice Assistant if Clippy isn’t currently showing. Now right-click and choose
Options. Uncheck every box except “Use the Office Assistant”. This will
prevent Clippy from appearing except when choosing “Show the Office As-
sistant” from the Help menu so you can decide for yourself if you want to
give Clippy the privilege of appearing on your screen.

If what you want is a completely Clippy-free Word, just unchecking “Use
the Office Assistant” isn’t enough. If you or anyone else clicks “Show the
Office Assistant,” Clippy is re-enabled (yes, the box is checked again). Com-
pletely sending Clippy back to the bit bucket from whence he came requires
a more permanent solution. Choose Start → Run and type appwiz.cpl. This
shortcut is an easy way to access Add/Remove Programs (or, as Microsoft
calls it in Vista, “Programs and Features → Uninstall or Change a Pro-
gram”). Find Office in the list and hit whichever option includes “Change.”
In the resulting wizard, check “Choose Advanced Customization of Pro-
grams” or something similar. (Different versions will no doubt be slightly
different.) Click the plus next to “Office Shared Features” and click the hard
drive icon by “Office Assistant.” Choose “Not Available.” Now click through
the rest of the wizard and Clippy ought to be gone for good. That is, unless
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you reinstall him.

Firefox

There’s a new update out for Firefox. If you ever hear about a new version
and want to know if you have it, simply choose Help → About and check the
version number.

Internet Explorer

You can check your version the same way, except because of Microsoft’s
“Menus are bad for you” campaign, you’ll have to hit Alt to display the
toolbar before you can check the version.

Google Chrome

If you’ve tried Chrome, you’ve probably noticed the weird bookmark system
and been very confused about what’s happening. Here’s how it works:

� When you click the star icon to make a bookmark, the site is book-
marked immediately in the folder that you last used for a bookmark.

� If you click Close, it stays there.

� If you choose another folder from the drop-down, it moves to that
folder. If you hit Edit, you can create new folders.

� To get to any bookmarks you have put anywhere but the “Bookmarks
Toolbar”, click Other Bookmarks at the end of said toolbar.

� If you click the star icon while it’s yellow, signifying that that page is
in your Bookmarks, you can edit it at any time.

General Windows

How would you like to have a toolbar along the side of your screen that shows
the current contents of a folder? You can have it on top of everything (so it’s
always visible) or not. And it’s deceptively simple: just drag the folder you
want to use to an unused edge of the screen. To set a few simple options,
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just right-click on an empty section. If you want to get rid of it, just choose
Close Toolbar from the right-click menu.
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Technical Geekery Blog
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21: Ten Ways to Keep Your Pass-
words Safe

We all know that other people stealing your passwords is bad, because then
they can get into your stuff and do all sorts of bad stuff. But many people
do things that can get their passwords stolen every day, because they don’t
believe that something bad will happen to them, because they’re too lazy,
or because they don’t realize what they’re doing. (I apologize for sounding
like a 3-year-old while trying to generalize.) In this note, I will explain some
of the ways people can get your password as well as some tips for how to
prevent it.

No computer system, no matter how secure, can resist attack indefinitely.
There is always some way to break the security. The goal, then, of security,
is simply to slow down attackers so much that the method of break-in is
impractical or they give up and move on to an easier target. If your computer
looks well-secured, unless crackers have a very good reason to target you in
particular, they’re likely to move on.

First of all, don’t forget that your passwords should ideally all be different,
or at least some of them should be different.

1. Giving someone your password

It seems stupid that I need to include this, but people do it quite a bit. Are
you sharing any kind of account with someone? You just gave them your
password. Saved a password in your browser on a shared computer? You
just gave them your password. (And not only can they log on there, they
can also find what password is stored and write it down for use later.) And
plenty of people share their passwords with others so they can easily log on.

Now I’m not saying that sharing passwords is inherently bad, just that
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you need to be cautious. Every person that knows a password multiplies
the risk of having it stolen or social-engineered (more on that later). Just
because you trust someone completely doesn’t mean that they will keep your
password with the most care possible. If you need to share your password
with someone, make sure you know for sure that they will not write it down
or save it and that they are smart about social engineering.

If for some reason you need to share a password with someone you don’t
know much about, you can always change your password temporarily and
then change it back later.

2. Shoulder surfing

Although it sounds like one of those stupid things people try to do at rock
concerts, it’s almost undoubtedly the oldest and most low-tech way to steal
a password. All you have to do is get behind someone and watch them enter
their password.

Since passwords were developed, login screens have hidden the typed
characters in password fields from view to make shoulder surfing much more
difficult. However, someone who gets lucky, has sharp eyes, or tries multiple
times will have a fairly good chance of getting your password by looking at
the keyboard. Since most people use the same password multiple times (hey,
even me, and I’m writing about security here), stealing one password will
allow them to get into multiple accounts. (And by the way, this problem isn’t
limited to computer terminals; you should always cover the PIN pad with
your hand when entering numbers at an ATM or store checkout. Besides the
chance of someone walking behind you and spotting your number, crackers
have been known to place cameras aimed at the PIN pads to catch unwary
users.)

Obviously, if your computer is placed in a closed room, it’s going to
be pretty hard for someone to sneak in behind you and shoulder-surf your
password without you noticing. However, be careful if you invite someone
you don’t trust into this area; shoulder surfing is one of the things people
tend not to think about. If your computer is easily visible, especially in a
crowded and noisy area, you have a much bigger problem. Not only are you
less likely to notice someone sneaking up behind you, people will also feel
much more confident and are more likely to try to steal your password.

There are a few things you can do to try to prevent your password from
being shoulder-surfed. There are two parts to successfully stealing a pass-
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word in this manner, seeing the password and remembering the password
until you get a chance to write it down. You can do quite a bit to help in
both areas. First of all, the more complicated and nonsensical the password
is, the less likely someone is to remember it. Also, it will be much harder to
see what is being entered. A password like “password” has a pattern that
will be easily recognized, but a password like “e58flc” is very unlikely to be
“read” correctly, and even more unlikely to be remembered. Also, avoid long
strings of contiguous or repeating letters, like “qwerty” or “adadadad.” Ev-
eryone can easily spot these. Secondly, learn to type your password as fast
as possible. If you hit the keys so fast that nobody can see what you’re typ-
ing, you’re automatically safe. Thirdly, learn to touch-type. It will improve
your overall computing experience tremendously, and it might take a while
to figure out, but it’s totally worth it. For security, not only are you able to
type your password much faster, your fingers also cover the keyboard without
any effort. Finally, if you’re in a high-risk environment (open area, crowded,
noisy, public), look behind you before you enter important passwords. Al-
though it seems paranoid, you might even consider getting a monitor mirror,
which clips onto your monitor and shows you what’s behind you (see http:

//www.thinkgeek.com/computing/accessories/2940/). Not only will it
allow you to catch shoulder surfers in the act and know when someone has
stolen your password and you need to change it, crackers are also far more
likely to move on to an easier target.

3. Search and you will find. . .

Many people have difficulty remembering passwords, so they write them
down on sticky notes and throw them in desk drawers or stick them to the
monitor. Enterprising crackers can easily find these notes and. . . voila, they
have a valid password.

This one’s easy to combat—don’t write your password down. Never write
your password down. Never, ever write your password down. Period. By
writing down your password, you work against the whole idea of a password.
If you must save passwords in your browser, make sure they’re not important,
and make sure your computer requires a login password while you’re away
from it (e.g. lock the workstation, make screen saver require password after
it kicks in, log off, etc.)

If you have trouble remembering your passwords, consider using a pass-
word manager (see http://keepass.info/). A password manager stores all

http://www.thinkgeek.com/computing/accessories/2940/
http://www.thinkgeek.com/computing/accessories/2940/
http://keepass.info/
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your passwords securely so you only have to remember one (strong) master
password or plug in a flash drive and unlock all your passwords. After a
timeout, when you log out or lock the file (when you leave the computer,
hopefully), or when you remove your flash drive, the file that stores your
password is unloaded and becomes inaccessible. This will also allow you to
more easily use stronger and different passwords.

4. Security vulnerabilities

No program of any significant size is safe from bugs. Matter of fact, no pro-
gram is safe from bugs. So it follows logically that most major programs have,
at some point, suffered from security vulnerabilities. This is not a problem
in itself; the problem is that people often fail to patch these vulnerabilities in
a timely manner. Nearly all security holes are patched well before they are
successfully exploited, so as long as you pay attention, you have very little
to worry about.

In terms of passwords, there are relatively few exploits of this sort, but it’s
always a good idea to keep everything up to date. Make sure automatic check-
for-updates features are turned on, update to the latest versions of programs
periodically, and keep a lookout for any published security advisories.

5. Database cracking

Database cracking is one of the most dangerous threats today. In database
cracking (which isn’t an official name, but it works, and I don’t think there is
an official name), a cracker or group of crackers breaks into a large database
kept by a company on a secure server and steals all the information on it,
which can be worth huge amounts of money. Database cracking is more
commonly talked about in terms of identity theft, but it is also an easy way
to steal emails, passwords (they are part of your identity, after all), and more.

Unfortunately, there’s very little you can do about database cracking; you
just have to trust that everyone you give your information to will do their
best to keep it secure.

6. Guess the password

Since too many people use simple passwords, a cracker has a decent chance
of being able to sit down in front of a computer or login page and guess the
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password within a few minutes, especially if he or she knows the person.
To combat this, you should make sure your password meets all of the

following guidelines:

� Does not include your username or any part of your username

� Does not include your real name, birth date, address, phone number,
email address, etc.

� Does not include any personal information that could be easily obtained
by a cracker; includes any information you have ever posted on the
Internet

� Is not a phrase like “password” typed with your hands shifted.

� Is not any of the passwords or similar to any of the passwords on the
“Top 500 Worst Passwords of All Time” list at http://www.whatsmypass.
com/the-top-500-worst-passwords-of-all-time.

� Includes at least 8 characters, the more the better.

� Also see the “Dictionary Attack” section for more guidelines.

7. Dictionary attack

A dictionary attack is basically a high-tech version of guessing the password.
In a dictionary attack, a cracker runs a program called a dictionary cracker
on the login screen they want to get the password from. The dictionary
cracker comes with a dictionary file containing the most common passwords.
The cracker program will try each password until it runs out of passwords, it
gets locked out for too many incorrect password attempts, or it guesses the
password correctly, in which case it will stop and tell the cracker what the
password was.

To protect yourself from dictionary attacks, make sure your password
meets the following guidelines:

� Is not any of the passwords or similar to any of the passwords on the
“Top 500 Worst Passwords of All Time” list at http://www.whatsmypass.
com/the-top-500-worst-passwords-of-all-time.

http://www.whatsmypass.com/the-top-500-worst-passwords-of-all-time
http://www.whatsmypass.com/the-top-500-worst-passwords-of-all-time
http://www.whatsmypass.com/the-top-500-worst-passwords-of-all-time
http://www.whatsmypass.com/the-top-500-worst-passwords-of-all-time
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� Does not include many sequential numbers or letters, letters contiguous
on the keyboard, or a combination of the two.

� Is not a common English word.

Also see the “Guess the password” section for more guidelines.

8. Brute-force

A brute-force attack consists of trying every possible password until the right
one is found. No matter what security measures are used, a brute-force attack
is guaranteed to eventually come up with the right answer. However, a brute-
force attack takes a really long time (unless it gets lucky); if you have a strong
password, it could take centuries to crack it using powerful computers.

To combat brute-force attacks, make sure you have a strong password,
using the password guidelines for #6 and #7.

9. Keylogging

A keylogger is a program or hardware device that stores all the keystrokes
entered into a computer. Someone can install a keylogger, then later come
back to retrieve the data collected, search through it for sequences that look
like passwords, then attempt those passwords.

To protect yourself against software keyloggers, make sure you have an
anti-malware program that includes spyware protection installed and that
it scans regularly. To protect yourself from hardware keyloggers, make sure
strangers cannot easily access where your keyboard plugs in, and check oc-
casionally to make sure there are no odd devices plugged into the system
(keyloggers are usually plugged in between the keyboard and the computer).

10. Social engineering

Social engineering (in a security context) is simply the process of trying to
trick someone into revealing confidential information or doing something that
will compromise the security of a system (like disabling security measures).
Social engineering is rarely attempted in person, but there’s no reason why it
cannot be. One of the reasons why it is so successful is that, in many cases,
it is not actually a crime, so even if the attacker is caught, they cannot be
arrested. The person has chosen to give the information, after all.
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To protect yourself from social engineering, you should be aware of the
fact that it is likely that someone will try to do it to you at some point.
First of all, never give your password to anyone else. Period. IT does not
need to know your password. Nobody ever needs to know your password
because of a “database crash”. If there really was a database crash, they’ll
make arrangements to get it fixed, and you won’t be able to log in until
then anyway. That really polite guy in Afghanistan who wants to deposit
$112,378.26 in your PayPal account does not need to know your password.

If there’s ever any doubt about whether someone really needs to know
a piece of information, hang up the phone or close the email, call or email
the person yourself with a number/address you know to be accurate, and ask
them if they asked for it. Better yet, walk or drive there yourself (if possible).
Most likely, they’ll be very interested to know that someone was trying to
represent them. 1

Never send your password or confidential information by email. There
is not a single legitimate organization or website that will ever ask you to
email them information about your account. Delete the email immediately,
or better yet, report it to the organization that was supposedly sending it.

Finally, if someone you don’t know ever calls you and asks for your infor-
mation, it’s best not to give it. If they want you to take a survey, fine, but
they don’t need to know your name, address, and email for it. If someone
gathers enough apparently innocuous information, one bit at a time, they
could soon have enough to impersonate you and steal more information or
money.

If your password gets stolen

Immediately go change your passwords for all websites and other logins that
use the password that has been stolen. Write them down temporarily (hope-
fully making at least some of them different to avoid this in the future).
Store them in a password manager if you aren’t going to remember them,
then burn or shred the password sheet and throw it away.

If the cracker has changed the password, attempt to recover it. Get in
touch with the company or follow a “My password has been stolen” proce-

1I recently read a very enlightening book called The Art of Deception: Controlling the
Human Element of Security by Kevin Mitnick (a former social engineer), which expands
on how social engineers fool people and what you can (try to) do to prevent it. If you’re
at all interested in this topic, I highly recommend it.
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dure. On many sites, like Gmail, you can fill out a long form telling about
your emailing habits, then the Google staff checks it against the logs and can
often give you your account back. Of course, in the meantime your email
may have been read, information stolen from it, and deleted, but at least you
have your account back. If you think any other passwords may have been
compromised by this account being taken over, go change them too.

Conclusion

I hope to have included most of the ways that passwords get taken. Read
it, make sure you follow all the guidelines, fix a few things if you haven’t,
then go on with your life knowing you’re that much more secure than other
people. Remember: There’s no way to stop the crackers, only slow them
down and hope for the best.



22: Input Methods

I don’t actually remember learning to use a mouse. Ever since I can remem-
ber, I’ve just been able to click on what I want and move the mouse where I
want. But when you think about it, the mouse isn’t actually the most intu-
itive input device. You move it sort of where you want the cursor to go, but
the direction and distance doesn’t really match the action of the cursor on
the screen. And most people are temporarily confused when learning about
computers for the first time by the fact that you can pick up the mouse
and move it to a completely new location without changing what’s on the
screen at all. Furthermore, you click over a certain location when you want
to activate something. But you have left-click, right-click, and zillions more
options to choose from. And sometimes you don’t actually click to select
something. We have learned to use mice and done so much work with them
that it requires no conscious effort to do something on the screen.

I do remember learning how to type properly, though. I went through
multiple programs and did lots of practice on my own, and by the time I
reached sixth grade I could type about 60 words per minute. The problem
is, after three more years of keyboarding, I have barely improved at all,
because I had already nearly reached the upper limit of how fast my fingers
could go. This is a major limit to typing, but as I will talk about later, it
still has certain features that no other current technology can offer.

We (and I am often guilty of this) frequently talk about being able to
input or write something “as fast as you can think.” And it’s true that you
can only think so fast. For instance, before I started writing this sentence, I
stopped typing for a few seconds to get my thoughts together about where
this post was going. But when you get a thought about something you’re
trying to write, you are still limited by the speed that you can type it.
For that matter, the same thing happens when speaking. It’s just that it
seems much more natural for some reason, and that we’ve somehow trained
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ourselves not to notice. This problem is basically unsolvable, but it’s one of
the things to keep in mind when talking about input; how close can you get
to that limit? Some technologies, like typing and speech recognition, can do
fairly well. Others, like texting, entering text on graphing calculators, and
using those little tiny keyboards that come on way too many mobile devices,
do very poorly. Writing by hand comes somewhere in the middle. Generally,
if entering something into a device is slower than hand-writing it, it’s not
worth my time.

There’s also the question of errors. How likely are you or the machine to
screw up? When there’s an error, you have to spend time correcting it, and
could potentially screw something major up, like deleting an irreplaceable file
or buying something you didn’t really want. We have to accept some errors
or it would be nearly impossible to go through our lives, but too many and
people start to get really frustrated. If you wanted to never miskey a letter
when typing, you would type at about one-quarter of the speed you could
reach otherwise. Most typists simply accept the fact that they will make
errors and simply backspace them just as fast as they made them, go on, and
not even notice that they spend half as much time fixing errors as they do
actually keying new text. If you had to never click the wrong button, you
would have to hold your hand steady and triple-check before clicking every
button. Obviously, if you’re about to do something that cannot be undone,
some caution is warranted. But most of the time, you have to find the right
balance between speed and errors.

Currently, most people use a keyboard and mouse to work with their com-
puter. If they’re working with a mobile device, they might use a touch-screen
and mini-keyboard or telephone keypad instead. And this works perfectly
well. The problem is that they’re not perfectly efficient and they tend to
create ergonomic problems.

Option 1: Touch screen

Touch screens make plenty of sense on many levels, and are about as intu-
itive as you can get. Touch a place on the screen, and the cursor moves
there. Want to zoom? Just put two fingers on the screen and pinch it based
on which way you want to go (assuming your screen supports multi-touch).
Unfortunately, conventional touch-screens are very uncomfortable to use be-
cause you have to reach way out in front of you to use them. If you were to
solve that by placing the screen on your desk, then you have to strain your
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neck to look down. Either way, there’s that nasty problem of blocking your
view of the screen with your fingers.

Option 2: Voice Recognition

Voice recognition seems like a great idea on the surface. You don’t have to
learn to type or use a mouse, and you can just tell the computer what to do
instead. You can easily dictate documents, too, and most people can speak
faster than they can type, so that works better.

In reality, it’s not that great. First of all, voice recognition only has a
stated 99% accuracy, and in many cases, it’s a bit less than that. The errors
are not intolerable, but they are certainly annoying. In actuality, the number
of errors is less than most people make while typing, but typing errors can be
corrected in less than a second by fast typists. Voice errors take a long time
to fix; you either have to reach for the keyboard and fix it or go through the
laborious process of scrolling to the word and reading it out to be selected
(and if it doesn’t recognize that word, you might have a hard time selecting
it) and then hope that it recognizes the word the second time around. Most
good packages can “learn” and thus have less errors over time, but our voices
are so complex that a computer has a hard time understanding what would
be simple to us.

However, if we decided voice recognition was the way to go, we could work
hard on the technology and greatly improve the accuracy, which is getting
better all the time. Unfortunately, that’s not the extent of the problems.
First of all, there’s the issue that speaking makes noise. If you’re in an office
environment without closed doors, not only will loads of people be distracted
by what other people are doing, there’s a chance that the software might get
confused too. Also, people like the fact that others can’t tell what they’re
typing. It would be hard to do something even semi-privately in a crowded
area using voice recognition. Next, there’s the fact that it’s much harder
to erase large blocks of text. If you type a sentence that doesn’t work, you
can just backspace it in a couple of seconds or even correct it in places using
your arrow keys. Correcting text takes forever, because it’s not easy to speak
about appearances. I’m going to reference a Science Olympiad event called
“Write It Do It” here. In this event, you get something built out of Legos or
Tinkertoys, and you have 25 minutes to write directions for your teammate.
Then he has to try to build an exact replica with only your directions. The
same basic problem exists here. It’s much simpler to point and click at the
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word you want to delete than to describe where it is located on the page.
Revising long documents could potentially take hours just because simple
tasks like scrolling and deleting words require long, multi-part commands.
And finally, our voices don’t like talking for long periods of time. Just as
people today hurt their wrists and fingers from typing too much, workers
who talked for eight hours a day without stopping wouldn’t be very happy
about how they felt afterwards.

Option 3: Touchpads/Graphics Tablets

Touchpads are those annoying tiny little things you see on laptops. Graphics
tablets are basically big touchpads that you use with a pen. Either way, you
point at an absolute location on the screen, rather than move the pointer
relative to its current position like you do on a mouse. If you’re confused,
think about how you can pick the mouse up and move it to the other side
of the keyboard and the pointer will stay in the same spot. That’s relative,
because your movement of the mouse moves the pointer relative to its original
location. In contrast, in absolute location, tapping in the upper-left corner of
the pad will always move the pointer to the upper-left corner of the screen.
Hitting in the middle will always move to the middle of the screen, regardless
of where the pointer was before.

Basically, touchpads offer many more options than a mouse, because you
can manipulate them with more than one finger at a time, provided the pad
and software supports multi-touch. Some concepts have taken this to the next
level (see http://10gui.com/). They also may offer better ergonomics.

Option 4: Thinking

It can’t possibly go mainstream anytime soon, but being able to manipulate
your computer simply by thinking certainly offers a lot of possibilities. First
of all, it completely eliminates the issue we’ve always had before of somehow
transferring what you’re thinking into a physical medium so what you’re
doing can be tracked. Second, all the problems that have been discussed
earlier are solved: you don’t have to reach anywhere, it’s silent, and you
don’t even have to move.

There are a few problems I can think of, though. First of all, there has to
be some way to distinguish between what you’re considering and what you
actually want to do. If I’m typing or using voice recognition, I can think

http://10gui.com/
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before deciding what I’m going to write, then input it. If the computer is
just trying to turn my thoughts into words, will it just place random words
that are going through my mind on the screen? Will it know when I’m just
paused to collect my thoughts and enter completely unrelated things?

Also, we’re used to having to do something to have something happen.
It would not be a particularly easy transition. People might turn away to do
something else and not realize that they hadn’t turned it off and strange stuff
would be happening on the computer. Perhaps having some sort of dummy
device would be helpful (say, a mouse that didn’t do anything). Would you
be able to reliably think about where you wanted the mouse pointer, and
once again, would it be able to tell the difference between considering and
actually wanting to click somewhere?

Conclusion

I’m sure there are many other things you can think of; these were just my first
thoughts. Feel free to add your thoughts by clicking on the “Comments” link;
if there’s something good, I may add it to here. And by the way, I noticed
that I have overused semicolons in this conclusion; they are quite useful,
though.
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23: Installing Windows

Microsoft and many people on the Web are claiming that Windows can now
be installed by a novice computer user. After installing on my computer,
I thought that installation had certainly come a long way. But after my
experience helping another user install on his computer, I beg to differ.

Our plan was to back up everything, take some Windows settings with
Windows Easy Transfer (a program for moving settings and files to a new or
freshly installed computer), wipe the hard drive, and create two partitions:
one for data and one for the system files. Fairly standard procedure. (For
those of you who don’t know, a partition is just a section on a hard drive that
appears as a separate drive, allowing you to, in effect, split one physical drive
into multiple drives.) So we backed up, put the CD in the drive, restarted,
and got into the partitioner. We set things up as planned, then moved on
with the installation, which was amazingly simple, elegant, and fast.

Then we got into Windows for the first time after waiting about 20 min-
utes for copying files. It looked great until I realized that we had selected the
data partition as the system partition and vice versa (one was significantly
larger than the other). Oh, well, haven’t done much yet, so just re-install.
But it would have been nice if the installer had been clearer, because once
you’re done partitioning, you would naturally hit “Next” in the installer.
The only hint that it wasn’t quite so simple was the title, “Select the drive
you want to install Windows on,” indicating that the entry you had selected
when you hit Next would select the system drive. It would have been much
better to open a second dialog box if you wanted to modify the partitions,
and not provide a way to change partitions from the selection window. Mi-
nor bad design there; a novice user would probably not have changed the
partition table, though, and thus would not have hit this problem, so I can’t
really cite this as part of my argument.

Once this worked, we opened Registry Editor and told it to put the
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desktop and other data folders onto the data partition in folders we had
set up, finishing the partitioning arrangement. (If you don’t get that, you
don’t need to to understand the rest.) Worked great. We installed a few
other programs, then took an image backup of the hard drive in case we had
to restore it later. Then, satisfied that the installation had finished, and that
the user could copy his data files back the next day, I left.

The next day, I headed back over to deal with any problems, and to
explain some of the new features. When I arrived, I learned that there
was a sound problem. Uh-oh. We had installed a new sound card fairly
recently (and the reason is the topic of another rant), which was infamous
for having bad support. The user demonstrated the problem, and I did a
little thinking. Audio played on the computer worked fine, but audio in web
video was horribly distorted into booming sounds (as if it was way too slow),
and squeaking sounds (as if it was way too fast). That led me to suspect
Flash, the program that plays most of those videos, as the culprit. So, first
thing we tried (after rebooting and using a different browser, of course) was
to reinstall Flash. That was easy, but the problem was just as bad as ever.
We did a load of googling and came up with nothing. (At this point, I
realized that two people less technical than us might have given up.) We
tried installing several drivers and packages that other people said worked,
but they refused to install because they “couldn’t find a product installed”,
or simply crashed. (The driver is software needed to control a hardware
device, and possibly the problem here.) We tried installing the driver found
on the CD that had shipped with it, but it blue-screened. Then I had to
leave and promised to come back as soon as possible.

While I was gone, I considered switching out the sound card to see if it
was the problem, but when I came back, the user had another idea. After
visiting the Rocketfish website (the people who made the sound card), he
had found a driver listed as compatible with Windows 7. This wouldn’t have
been odd except for the fact that when we had looked two days before, there
had not been any drivers or support or even a mention of the product on
the website. We downloaded and installed it, and, wonder of all wonders, it
worked.

A week later (knock on wood), there have been no more problems. But
if someone thinks a novice user is capable of doing something like that unas-
sisted, I want to talk to them. Naturally, that will only happen on a small
percentage of installations, but if it does and you have nobody to help you,
you’re in a major jam.



24: Personal Information on the
Internet

The amount of information you can get on the Internet about someone is
scary. So, just for fun, I decided to see how much information about myself I
could get using nothing but Google and my name. I hoped to at least come
up with my name and address. So I started by Googling “soren bjornstad”.
First up were two Twitter pages, but they were dead ends. Nothing but
screen name and status updates. Next was a Family Links page. That’s
better: names of family members and a link to my web page. The site
looked a bit broke, but I found an email, and better yet, the domain name.
I visited whois.com, ran a database lookup, and whatdayaknow, there’s my
phone number, address, city, state, and country. While you can have your
information removed from the WHOIS listing (for a fee, of course), I don’t
feel that one should be allowed to hide one’s information if running a website,
so I naturally don’t do it.

Of course, this would only be available if you happen to have a website. So
back to Google to keep looking, pretending I only have the name still. Oh,
look—I was in Science Olympiad at Ben Franklin Middle School in 2008.
Oh, look—Facebook. But unless I’m a friend of myself and logged in, I can’t
access anything but a picture that barely looks like me and an unrelated
comment. But, there are some names of friends that might be able to tell me
something if I looked them up. On to the second page. Here’s an obituary,
with names of family members that I might be able to look up and/or call
to get more information from.

Oh, look—I play violin too, in the Benjamin Franklin Middle School
orchestra. Ooh, I played violin at a concert in Munster too. There’s my
grade, and my city, if I hadn’t gotten that already. And then I’m kind of
stuck, so I try putting in other information I have with my name to drag up
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more specific stuff, but no luck.
At this point, though, I have many other names. Chances are that if I

look them up, I’ll get some contact information, and I can probably trick one
of them into giving me, say, my email or phone number (perhaps I have an
opportunity for me to play violin for something, or to participate in Science
Olympiad camp). (I didn’t try that, since it would take time, and I didn’t
feel like purposefully fooling people I knew, plus there would be a pretty
good chance they would recognize my voice). Let’s try that. With my phone
number (which won’t be too hard to get) I type it into Google, and—huh,
there’s my address and parents’ names.

I should also mention that, not having any major legal documentation
yet, my name doesn’t appear in many directories. Try searching on yourself.
It may be rather enlightening.



25: Tech Support

Let’s face it: We all know that tech support in this day and age is horrible.
You have to wait for ages to actually talk to someone, only to be put on

hold again because the first person who answers can’t do anything more than
tell you to restart (even if the problem is that your computer won’t restart).
You can often barely understand the person who’s supposed to be helping
you, and they most likely have had almost no training. After an hour of this,
you often get told to call someone else. On one memorable occasion, I waited
on hold for 45 minutes and then the system hung up on me.

What’s with this? Plenty of people I’ve talked to say that years ago,
when computers were still not too common, you could call tech support
and immediately get people who knew what they were talking about and
exactly what needed to be done. In reality, I think users are partly to blame
for calling about issues they could resolve themselves, making call centers
more ready for those types of calls. Most experienced users call only as a
last resort, because they know that they’re going to have to deal with this,
only to be met with an hour of redoing stuff they’ve already done. More to
blame, though, are the vendors, who can save money by assigning calls to
people who know nothing about the product. In fact, I doubt that it really
helps much, because it just leads to more unsatisfied customers and more
time spent on the calls. In a country where we can go back to the store
and return almost anything with no questions asked, am I the only one who
thinks this is absurd?

I don’t even care to count how many hours I’ve spent talking on the
phone with people who often don’t resolve my problem, but it must be at
least thirty. Recently, someone I know bought a new computer, only to find
that the sound card had a known problem. We were trying to copy a cassette
tape to the computer, and we weren’t sure exactly what we could do, but
decided to call support in the hopes of having a working sound card sent to
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us. After explaining the problem, the rep had us download software that let
her access the computer remotely, then proceeded to check that the volume
was up. After this, we got transferred no less than four times, often without
doing more than explaining the issue. The best part, however, was when one
of the reps said, “Well, if you want to hear sound from your tape recorder,
you should just hook it up to the speakers.”

The next day, we got back on the phone, and after another two hours
of being transferred, and a time when we were on hold and they were doing
things remotely on the computer without our consent, we finally gave up,
went to Best Buy, and bought a new sound card, which worked perfectly. But
afterwards, I realized that we actually knew more than tech support, after
just a little bit of experimenting and searching Google. It’s just pathetic,
and what a waste of four hours.

Another time that was even worse was when I bought a new computer
in 2005. It was an HP (a brand which I have since decided to avoid if there
is an easy choice), and at first, it felt great, coming from a Windows ME
computer with a 900Mhz Pentium and 64MB of RAM. But after about a
month, I started to notice weird things: the computer rebooted randomly
with Blue Screens of Death, I got messages (related to that) that said “The
system has recovered from a serious error” on startup, the NumLock key
wasn’t working right, and when I put programs full-screen, the screen would
go black when I exited, and I would have to put it in standby mode and come
out again to fix it.

I called tech support a few times about this, and none of it actually
worked. Finally I got sick of the full-screen problem, and after I had called
about something else, when the rep asked, “Is there anything else we can
help you with today?”, I told him about that problem. I was told that it
“was a problem with the operating system” and that I would have to reinstall
Windows. So I did. However, once it was done, the problems were worse
than before. I tried completely reformatting the hard drive and reinstalling
again, and had no more luck. So I called again, and, after about an hour and
a half, finally made it to someone who agreed to let me ship it in for repair.

When it came back from repair, I was told that they had found a problem
with the real-time clock and that it had been fixed. Nope, same errors, and
to add insult to injury, the system didn’t turn on, and we had to actually
tape the power wires somewhere to get it to turn on (I suspect it was a loose
connection). I had it sent in for repair again, and they replaced the hard
drive. Same errors. Finally they shipped out a completely new system. It
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only had the full-screen problem, so I decided just to deal with it. It worked
fine after that until about a year later, when it completely crashed. I tried
to install Windows and, after a few confusing dialog boxes on first startup,
ended up at a screen telling me to input a license key, which I didn’t have.
The system was out of warranty, but I called anyway and they agreed to help.
We reformatted the hard drive yet again (the fourth time in the computer’s
lifetime), and it worked, although the full-screen error was still there.

About a year and a half later, I bought a new computer (an HP, because
the specs were too good to pass up for the price). Only recently, I managed
to get rid of the Vista installation that had gotten so screwed up that it took
over ten minutes to boot, two to shut down (so that I usually just hit the
reset button), and a few seconds to switch programs. This installation had
only been on for a year, and it’s not like I had been abusing it.

There was also the time that a hard drive I had bought (it was labeled
“Certified Repaired”, which meant it had broken in the past, so I was only
using it for backup) completely broke within the stingy 180 day warranty
period. I called the support number (which by the way, was a long distance
call for me), waited on hold burning money for ten minutes, and eventually
was told that a return request had been approved already. Turns out I had
already submitted one some months previously for an issue that had been my
fault, and was never notified that it had been approved. What bad service.

There are, fortunately, a few success stories, like the time I dealt with
a brand-new computer that had a CD burner that was making a noise like
a jet engine. After about fifteen minutes, we were told that a tech would
be coming to the house the next day to replace the drive, which worked
perfectly.

I have a feeling that computer stores with support services are going to
be getting a lot more business if this keeps up. People just don’t have time
to deal with this sort of thing, and they are willing to pay if their computer
works again in a couple of hours without any more work than driving their
system a couple of miles. One statistic I have read stated that 20% of all
computers are returned. Now what does that mean? When you return
something, you either discovered you didn’t want it or need it, it was broken,
or you couldn’t get it to work and gave up. People don’t make purchases like
computers without knowing that they really want them, and the other two
both mean bad reliability and bad tech support.

After my experiences, I’ve decided that I’m not going to buy another
desktop from a manufacturer again. I’m more than willing to put one to-
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gether myself to save a few dollars, and I’d much prefer to know that what
doesn’t work is my fault and figure it out myself, especially since I’m fairly
confident in my ability to do it right.



26: Complex technology. . . better?

At my old school, the administration once had a brilliant idea. All the
clocks were frequently unsynchronized, and so people didn’t know what time
the bell was actually going to ring. So they decided to buy atomic clocks
for every room, naturally assuming that such clocks would always be right.
Great idea, you say? Not quite. They bought all the clocks, put them up,
and followed the directions to synchronize them. Unfortunately, the time
that they synchronized to was simply incorrect. They ultimately had to put
all the old clocks back up and were left with a huge stack of non-working
atomic clocks that they apparently couldn’t return.

Why is it that complex technology invariably just doesn’t work as well?
Of course, the easy answer is that there’s simply much more to go wrong.
But, even if you assume that everything works perfectly, simpler stuff tends
to work better anyway. I’ve tried numerous methods of keeping calendars,
lists, and reminding myself to do various things. Ultimately, I always find
something new, think it’s a great idea, and then I end up missing things
anyway. The only method I’ve found that actually works nearly every time
is putting a sticky note on my monitor.

Why does this work? First of all, I look at the monitor whenever I
turn on my computer and while I’m working on it, which is fairly often.
Also, the computer is in the middle of my room and on a desk where I keep
other assorted objects, so I end up looking at it anyway. In contrast to a
computerized calendar like the one included in Microsoft Outlook, it simply
works better. With Outlook, my computer may make a noise at the right
time or send me an email, but sticky notes can’t accidentally be turned off,
nor can a bug prevent them from working. They may fall off, but that’s
a small chance compared to the possibility of me accidentally deleting the
event or having the program closed. Besides, it’s much harder to miss a
sticky note that is in your line of sight than a window buried under your 60
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tabs of internet work or an email in your 150 unread messages. I have even
tried my cell phone. For some people, this works okay, but besides the hassle
of inputting an event using your phone keypad, I don’t always have mine
with me. When I go out, I usually do, but it’s frequently turned off because
I’m in school or something similar. In the rare instances when I actually get
the notice, I do, in fact, remember, but this happens so rarely that it doesn’t
actually help. All this just goes to show that, despite the fact that there
are plenty of complex organization systems that work, if you do something
extremely simple and get in the habit of looking at it, you’ll be very well
off. (I once read a story about a professional attending a conference about
cutting-edge mobile technology who was using a paper planner.)

This same thing came into my head when we recently learned about the
accelerator issue in certain Toyota cars. If you’re reading this far in the
future or never picked up on it, accelerator pedals were simply getting stuck,
which had been a recurring issue on those cars (nobody apparently saw fit
to fix the problem earlier). The bigger problem, however, was that the brake
pedal was not designed to override the accelerator, since it was computer-
controlled. (Of course, here, a possibly more relevant question is “What
idiot decided that going faster was more important than stopping?”) In fact,
if you held down the brake and then stepped on the accelerator pedal, your
car would still move. In certain cars which recover power when braking,
having the brake electronically controlled is a necessity. But in most of
them, a mechanical brake would have worked just as well, and the problem
would have been simply annoying, rather than life-threatening, when one
could actually stop. What’s the point of adding another unnecessary layer
of complexity?

I’ve come to the conclusion that simpler things are nearly always better.
Don’t let the crazy marketing fool you.



27: Concept Idea: The Phone
Control System

Note: the Concept Idea is a new series I’m hoping to start describing technol-
ogy I envision. They are not anything that has happened, nor is necessarily
going to happen.

We’ve all experienced someone’s cell phone ringing at an inconvenient
time. Even more annoyingly, people have developed a nasty tendency to
ignore everyone around them at times when they should be paying attention
and use their phones instead. Even more importantly, there are problems
with people communicating information that is supposed to be kept secret.
This can be done by text message, or by taking a picture (for instance, a
student sending a picture of a test to his friend who is going to take the test
the next period). Some people suggest jamming signals to prevent people
from using their phones in certain places, but this hardly seems like an ideal
solution. Something better would look like this.

Point 1: Control Zones

Any institution that desired to put restrictions on cell phone use could pur-
chase a control box that allows them to do so. With the control box, three
other nodes would be provided, which would end the controlled zone and
form a restricted-area triangle. These nodes would prevent any restrictions
beyond the location of the triangle. When setting up the zone, the people
responsible would have to make sure that the zone did not extend beyond
their own property. (If a conflict were to occur, there could be an inspector
to make people adjust the controlled area.) I don’t know exactly how such a
thing could be set up, but this is, after all, a concept.
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Point 2: Control Levels

� Level 0: Unrestricted—cell phones would work normally as if they
were outside any control zone.

� Level 1: Silenced—If sound level was above vibrate, the level would au-
tomatically be lowered to vibrate on any phones that were on. (Leaving
the area would restore the previous setting.) Incoming calls could be
received, but answering the call and placing calls would be prohibited.
Attempting to place or answer a call would give a message instructing
the user where to go in order to talk. Text messaging and internet
use would be allowed, although the backlight level would be lowered
to minimize distraction to surrounding people in the dark. This would
be a good mode to use in many public places, like concerts and movie
theaters, because it would allow people to be notified of important calls
and events (because, let’s face it, there are some times when being in
contact can actually be important), but not distract others.

� Level 2: Communications Blocked—Calling, text messaging, internet
use, and any other activities that used a cell phone signal would be
blocked, as if there was no signal available. Once again, attempting
to do one of these things would trigger a message pointing the user to
an unrestricted area. The camera, calendar, calculator, some iPhone
apps, etc., would be unaffected.

� Level 3: Communications+Camera Blocked—To prevent removal of
important information (like pictures of tests) from the area, the camera
would also not work. Attempting to use the camera would trigger a
message stating that no photography was permitted in the area. (Al-
though one could bring in a dedicated camera to bypass this restriction,
someone using an actual camera would be easily spotted.) This would
probably be a good level for schools, so that students could use tools
that would be appropriate for academic use, but not be able to use
phones to cheat or talk to friends.

� Level 4: Cell Phone Blocked—Any cell phones that were on upon
entering the area would turn off. Attempting to turn on the phone
would result in a message directing the user to move to an unrestricted
area to use his phone. This would be a good mode to use, for instance,
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in testing environments. For instance, when I recently went to take
the SAT, people were discouraged from bringing phones in, and anyone
whose phone went off during the test would be dismissed and have
their scores canceled. For me, I needed my phone to call for a ride
home when the test was done, so I resorted to removing the battery
and placing both the battery and the phone in my bag. Having this
mode would remove the problem completely.

Point 3: Emergency Use

I can just see the people who are opposed to this sort of control going, “But
what if there’s an emergency?”

� An emergency switch would be located inside the battery compart-
ment of each phone (to prevent accidentally triggering it). Turning
the switch would allow the phone to pass through the communications
and phone blocked modes (after answering a question on the screen as
extra confirmation). To prevent abuse, the phone would immediately
and automatically connect you to 911.

� The control box, which would be located in a public place, would have
an emergency lever that would call 911 and activate emergency mode.

� Emergency mode would be triggered by turning the switch on one’s
phone or by pulling the lever that would be situated on the control
box. Emergency mode would have the following effects:

– The mode would immediately be set to unrestricted, allowing any-
one to make any calls. If the mode was triggered from a phone,
the control box would also submit an emergency call.

– Whatever device triggered the mode would be connected to 911.

– An event would be logged on the control box stating what device
triggered it, to track down people setting off false alarms.

– An alarm would sound on anyone’s phone who had been blocked
from switching it on within the past few minutes, allowing them
to make any important calls they had been trying to make. A
message stating that an emergency mode had been triggered would
also appear on the control box.
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– The mode would remain in unrestricted until an administrator
reviewed it and reset the mode.

Point 4: Control Box

The control box would be located in a public, easily accessible place. On
a display at the front of the control box, anyone would be able to see the
area the zone extended to and the mode the area was currently in. An
administrator could also log in from the control box to change settings, the
mode, and review logs and emergency events. Logging in would require a key
and a passcode, to avoid anybody messing with it. The control box would
also log any failed logins.

Point 5: Technical Aspects

Setting up a system that could control phone use effectively would be fairly
complicated, but could be accomplished by having phones listen for signals
from control boxes. The signal would state the current zone the system was
in, and would immediately cause their respective effects on the phone when
received. Also, all communications would be intercepted by the control box,
and provided that they weren’t from a banned phone, sent on to the tower.
To lower the chance of phones’ restrictions being cracked and broken, it could
be made simply illegal to own such a phone. Therefore, anyone caught using
a phone breaking restrictions would be automatically pointed out as guilty.
In addition, control boxes could be set up to block all communications from
a phone (ban the phone) that had been caught breaking the restrictions. As
extra defense against this, control boxes could log events that occurred on the
phone, such as a ringtone sounding. (Perhaps that’s a little bit overboard, as
it could be seen as an invasion of privacy; it could also possibly be spoofed
by having one’s cracked phone firmware send incorrect messages to the log.
If the system really worked, anyone whose phone went off in violation of
restrictions might be so unaccepted by society that someone would report
them anyway.)

Point 6: Setup

Of course, phones can’t be made to respond to these signals out of the blue,
nor can my suggested emergency switch be reasonably added to phones that
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already exist. The simplest way, therefore, to get any such system to work
would be to simply include the necessary software and logic on all new phones,
and after some period of time (say, 7 years), all phones that were purchased
before that time would simply cease to work (after sufficient warning from
the provider, of course), and the rest of the system could be implemented.

Point 7: Conclusion

Naturally, I have no leverage whatsoever to get something like this working.
It’s a very ambitious concept, and I have severe doubts that our society will
welcome anything like this. Maybe you don’t agree with me on all the points;
maybe you don’t even agree that something like this is necessary. The thing
to remember is that having phones ringing during performances and at other
inappropriate times is extremely annoying, and that people have a tendency
to try to use phones when it is not reasonable to do so. If we can’t trust
people to take care of this themselves (and it seems that we can’t, from the
past few years), I see no other real solution than to implement some kind of
control. I don’t even trust myself to always turn off my phone at the right
times (and I’m writing this)—more than once, I’ve discovered I’ve left my
phone on during school, or an equally bad time.
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28: SimCity, Random Failures,
and the Core i7

These don’t seem to go together, do they? In fact, if you think the title makes
sense, you’re lying, crazy, or you’ve been following what I’ve been doing the
past couple of days.

Everything started when I woke up on Monday, my first day of spring
break. I slept until about 8:30, woke up, and figured I’d check my email
and maybe read the news before breakfast. I walked over to my computer,
which was in standby, hit the power button, and. . . nothing came up. The
fans started, but the monitor stayed in power-save. Thinking nothing of it,
I rebooted.

Guess what? The monitor still stayed in power-save mode. Okay, suppose
the monitor’s bad. Or maybe the cable; the last time the screen was all
green, I unrationally suspected the graphics card and bought a new one
before I realized the cable had died. But my second monitor wasn’t picking
the signal up either. So I walked down the stairs, grabbed our 21-inch TV,
which has a standard computer input, lugged it up, and plugged it in. Power
back on. Nothing.

I started thinking, “Hmm, what have I changed that might have caused
this?” Thing is, I hadn’t installed or changed anything. I had recently in-
stalled a sound card, but that was about a week before, and it had worked
flawlessly up until then. No, it seemed to point toward some sort of random
hardware failure.

I guess the graphics card has to be bad, right? Pull out the graphics card
and plug into the graphics built into the motherboard. No luck there either.
Maybe the settings are still set to use the nonexistant graphics card? Reset
the BIOS settings. No luck.

The computer didn’t seem to be POSTing (passing the power-on self
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test), since it wasn’t making the usual sounds it did right before it went to
the boot menu. Only problem was that I couldn’t see where it failed, since
the monitor wasn’t working. And the oh-so-unhelpful motherboard (which
came in the HP system I bought a couple of years back) didn’t make any
error beeps or have any helpful lights to tell me what the problem might be.

I did some googling, and found someone who suggested I unplug the
computer, hold the power button for 30 seconds, and plug it back in. Worth
a shot, I suppose. Surprise, surprise, it didn’t work. I removed the battery
that holds the settings and tested it, and the battery tester said it was low.
I suppose it’s worth a try, right? So I bought a new battery. Guess what?
The battery tester said it was low. Guess the battery tester’s broken too (or
at least can’t measure that type of battery properly). Naturally, the new
battery didn’t fix anything.

I started taking out RAM, unplugging the sound card and hard drives,
and more, trying to isolate the source of the problem. The same thing kept
happening. I was absolutely stumped.

Defeated, I called the Best Buy Geek Squad, and they told me they would
look at the system for free. So I dragged it over (getting envious looks and
exclamations of how large my case was from employees), and had them look
at it. They swapped out the graphics card and had no more luck than I had.
The final report was that my motherboard was probably bad.

That was what my assumption had been, too, but I hadn’t really wanted
to admit it. With nothing else left to do, I went home and ordered a new
one. Having a fair amount of money sitting around, I decided that I might
as well make the best of it and buy an upgrade that would last me a while,
so I bought 6 gigabytes of RAM, a Core i7 processor, and a motherboard.
The total bill was a somewhat painful $720.

When it came today, I spent three hours or so cracking the case open and
installing the stuff. I had never installed a processor before, and I’m not sure
I did such a great job at applying the thermal grease (which goes between
the processor and the heatsink), as it seems to be idling at a fairly high 44
degrees Celsius. (I set an alarm to notify me if the temperature breaks 60
degrees, so I know it’s starting to heat up and I might need to fix this.)

Nevertheless, my new setup just flies. I installed a clean copy of Windows
(and experienced inexplicable freezes during the start of the installation),
and there are hardly any delays. I actually feel like I should be typing and
mousing faster to compensate! I installed SimCity 4. On my largest city
(which I had nearly stopped playing because of the annoying frame rate and
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delays), the scrolling is totally smooth, I don’t have to wait on dialogs, and
it loads in a fraction of the time it used to.

I should reiterate how annoying this whole thing was. To have done
nothing at all wrong and to suddenly have the system not work at all is
unbelievably frustrating. In all our expectations of reliability, remember
that someday your computer could just quit working—yet another reason to
have backups and have some sort of plan for how to keep working if your
computer suddenly fails.

I uploaded four screenshots of SimCity 4 (in the city I was talking about)
so you can see how the graphics take some oomph to be displayed properly.
Note that this is only medium detail, too. http://snipurl.com/v1nmy

http://snipurl.com/v1nmy
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29: Who can you trust on the
Internet?

Introduction

Who can you trust on the Internet? It’s a question we have to face all the
time. Everyone knows that they shouldn’t email their credit card numbers to
that guy in Nigeria who really needs their help to keep his rightful inheritance
of $1,988,356.76 away from the evil government (and will pay you an absurd
amount of money to do it). But it gets harder than that.

Part One: Malware

There are lots of less-than-reputable websites that would love you to down-
load viruses from them. There are also some sites that offer “ad-supported”
software that puts so many ads on your PC that you can’t do anything
but look at ads (and it often can’t be removed through normal methods
either). Most of the time, you can easily tell when you’ve visited one of
those sites. (Of course, there are clearly still enough gullible people that
they continue making money, but I doubt you’re one of them if you’re read-
ing this blog.) Unfortunately for us, there are plenty of borderline websites,
where you can’t tell if the site is reputable or not. I’ve personally never been
burned by one of these sites (knock on wood), but you should always scan
even semi-questionable downloaded files with a good antivirus program, and
don’t run any ActiveX controls or allow other security warnings unless you’re
sure about the site. Your antivirus software is not invincible, though, and
ultimately the best defense against malware is to exercise common sense.
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My No-Nonsense Download Checklist

1. Do you really need this program? If you need a word processor or a
video editor to finish a project, then that’s a good download. If you
were just browsing the Internet and said, “Huh, that sounds cool,”
think for a minute before you decide to try it. If you install it and
don’t need it, not only do you raise your chances of getting hit by
malware, you also clog your PC with unnecessary garbage and waste
time downloading and installing it.

2. Does the program make any mention of being supported by ads or
requiring other (questionable-sounding) programs? If so, pass it by and
find something else. Although it may seem like a fair tradeoff at the
time, chances are very good you’ll regret it later—and such downloads
are far more likely to contain actively destructive or dangerous software.

3. Does the URL contain a load of unidentifiable characters? I don’t mean
at the end—that’s normal. I mean, instead of, say, http://earth.

google.com/download at the beginning, http://6ths7.free67.info/
73nds. Junk programs, especially ones that will steal your personal in-
formation or reformat your hard drive, frequently have URLs that are
cheap to obtain. Another common trick (for phishing sites too) is to use
something like http://microsoft.d6shc.com. Although many people
say “Oh, it’s Microsoft.com, must be good then”, anyone can change
the first part (microsoft, in this case), known as the subdomain, to
whatever they fancy. The part right before the .com is the only part
you actually have to register.

4. If the program didn’t pass one of those requirements, or you just aren’t
sure about it, try googling the function of the program. Chances are
very good you’ll find another free program with a less questionable
background, and quite possibly better features as well.

5. If you really want the program and aren’t sure of its legitimacy, down-
load it, scan it with your antivirus program, and back up your files first
or install it on a junk PC just in case. (Of course, you really should
have a valid backup at all times; I’ve got an upcoming feature on mak-
ing a backup script for yourself.) If your antivirus program comes up
with a warning, ditch it and find something better. It’s definitely not
worth the trouble.

http://earth.google.com/download
http://earth.google.com/download
http://6ths7.free67.info/73nds
http://6ths7.free67.info/73nds
http://microsoft.d6shc.com
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Despite my lobbying for the antivirus industry, I’m not saying the pro-
gram always knows better than you. If your antivirus program comes up with
a warning for a perfectly reputable program, like Microsoft Office or Spybot
Search and Destroy, check the warning a bit more carefully, and do some re-
search if you’re not sure. Although viruses can infect and damage legitimate
programs, it happens less and less nowadays, and it’s far more likely that the
scanner just made a mistake (or the program was performing a “suspicious”
activity, like Spybot accessing a spyware-filled folder to remove spyware).

Part Two: Collected Information

You don’t just have to deal with malware, though. Most websites collect
information about you, and you have to decide who you can trust with that
information. When you visit a website, a certain amount of information
can be collected about you automatically, and you can’t do a thing about
it. This information includes the browser and operating system you’re us-
ing and your IP (Internet Protocol) address, which uniquely identifies your
computer on the Internet. Normally, the website also collects any cookies
the website has stored on your computer. You can turn this off, but it has
a number of adverse affects on your web browsing, and only total privacy
freaks (or the same Internet purists who refuse to use any Web content be-
sides plain text) choose to do so. (One note: Cookies are not programs that
can look through your files and steal information. They’re not even necessar-
ily bad. That said, cookies can be used to track your browsing and shopping
habits; see http://www.tomsarazac.com/tom/opinions/cookies.html for
more information about cookies.)

Most of this information isn’t really earth-shaking; if you really care about
hiding any of it, check out http://the-cloak.com/. It’s what you give
websites that really matters. For instance, Google, with some settings, col-
lects information about what websites you visit in order to personalize your
searches. Most of the time, you have to decide how much privacy you’re
willing to give up in order to get useful functions.

Try this: Head over to http://www.google.com/dashboard and log in
with your Google account. (If you don’t have one, just follow along.) Scroll
down and check out all the stuff Google has stored about you. Bet you
didn’t know they stored all the websites you visited after searching while
logged in, and all the searches themselves. And even though you knew they
stored your contacts, emails, voicemails, and so on (if you use Gmail or other

http://www.tomsarazac.com/tom/opinions/cookies.html
http://the-cloak.com/
http://www.google.com/dashboard
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Google products extensively), it somehow seems a lot more impressive and
scary when it’s all in one place.

Check out these three screenshots:
http://www.thetechnicalgeekery.com/images/Google1.png

http://www.thetechnicalgeekery.com/images/Google2.png

http://www.thetechnicalgeekery.com/images/Google3.png

In the first one, you can see most of the Google searches I made in the
last two days, and that I’ve made 4,913 searches since Google enabled Web
history. This catches nearly all of the searches I’ve made on my home com-
puters, since I’m nearly always logged into Gmail, but I’d say that it probably
still only represents about half my searches. (Interestingly, I found that there
were searches on my history page I hadn’t made today, meaning that I had
accidentally left myself logged in on the family computer—oops. If you ever
accidentally leave yourself logged in on another computer, you can log in to
Gmail, click the Details link at the bottom of the page where it says “This
account is open in x other locations. . . ”, and choose Sign Out All Other
Sessions.) Still, Google has stored, and still has accessible, about half of my
searches all the way back to January 2008. That’s kind of cool, and a neat
way to look through what you’ve done on the Internet in the past, but it’s
also naturally a concern if someone else gains access to your Google account
(besides being able to log in and represent you on any Google service, and
some others). The other two shots show other parts of my history, including
all my stored emails, documents, and many phone calls and texts I’ve made
through Google Voice. Not displayed is also contact information for over 100
people.

The good news is that if you’re scared by the web history, you can easily
stop it from collecting items or clear some or all items from the history.
Just open up your Web History from the dashboard and select Pause or
Remove Items, on the left. (It should be noted that Incognito Mode in
Chrome does not prevent Web History from collecting items, although you
are not logged into your account in a new Incognito window and therefore
cannot have your searches collected. If you want to browse totally privately,
stay logged out of your account or pause the web history.) Other services
like Gmail are harder—you can’t really use email without leaving tracks
with someone, be it Google, Microsoft, or your ISP. However, I generally
trust Google with my information; they’ve had a fairly good record of not

http://www.thetechnicalgeekery.com/images/Google1.png
http://www.thetechnicalgeekery.com/images/Google2.png
http://www.thetechnicalgeekery.com/images/Google3.png
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throwing your information out the window, especially compared to some
other websites. (I’ve heard some people worried about what might happen
if Google was bought out and had a change of ownership; I say that’s not
currently a valid question, as Google is not within reach of any purchases.)

Facebook is much more questionable. It seems that they change their
privacy policy about every six months, and every time they seem to have some
absurd clause designed to make them more money that quickly gets picked
up by the media and causes public outrage. (Then they provide a public
apology and reverse that change, but some others may remain.) Although
(at the time of this writing), the privacy policy is fairly reasonable, it’s still
clear that they track everything you do and keep all your information and
posts, and who knows what could happen with them, especially since the
privacy policy can change at any time. (For a while there was even a note
that stated that Facebook gained ownership of anything you posted on the
site.)

The most important thing you need to worry about with your Google,
Facebook, and other accounts is that nobody steals your password. If anyone
ever gained access to my Google or maybe even Facebook accounts, they
could easily impersonate me—they immediately have many of the websites
I’ve visited and therefore know what I’m interested in, all my email, contact
information for all my friends, family, and more people, and can change my
Google Voice settings so they get my calls. Besides being much easier to do
than, say, a cracker stealing half their database or the company deciding to
release your information to the public, having your password stolen is one
thing you can easily guard against. Choose a strong password, don’t write
it down, and make sure nobody gets it. Sign out of the computer when
you leave it, and immediately change it if there’s a chance someone else
has stolen it. See http://thetechnicalgeekery.blogspot.com/2009/10/

ten-ways-to-keep-your-passwords-safe-we.html for more information
on the ways passwords get stolen and how to protect yourself.

I’m seriously considering keeping any information I’m even the least bit
concerned about off Facebook and maybe even off other websites, and put
it on my own website instead. I run the server, so nobody is going to mess
with my information except by breaking into it.

http://thetechnicalgeekery.blogspot.com/2009/10/ten-ways-to-keep-your-passwords-safe-we.html
http://thetechnicalgeekery.blogspot.com/2009/10/ten-ways-to-keep-your-passwords-safe-we.html
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30: OS Popularity

I had a question the other day: If everyone forgot everything they knew
about computers, how many people would still be using Windows?

Imagine that you decided you were going to completely remodel your
bathroom. Not being an expert on bathrooms, you don’t know much about
the various toilets, sinks, and bathtubs available, so you talk to a salesman,
and he helps you pick out something that you think will work well. Then he
says that you have a choice between the electric blue and lime green varieties
of toilet paper. Let’s assume that they look equally absurd, and you don’t
prefer one for its color. The salesman tells you that 90% of people buy the
electric blue type. Naturally, you choose the blue, because you assume that
if all those people use it, it must be the best.

But what you don’t know is going to hurt you. Had you taken the time to
do your research, you would have found out that electric blue toilet paper dyes
your toilet a funny color, clogs the drain on a regular basis, and occasionally
even spontaneously explodes. On the other hand, the green kind almost
never clogs the toilet, contains much more toilet paper on the same roll, and
doesn’t lose its dye.

Making the situation even more complicated is the existence of the burnt
orange variety of toilet paper. It is completely free, allows you to control the
exact amount of toilet paper you want to put on a roll (allowing for dispensers
of different sizes), lets you refill your toilet paper roll any time you want,
and clogs your toilet only in very exceptional circumstances. Unfortunately,
you can’t buy it along with your bathroom—you have to install it yourself
later. You also need to read the short manual in order to learn how to use
it correctly. And the existence of this toilet paper is never even mentioned
when you buy your toilet. A small number of people find out about and
properly set up their orange toilet paper and are very happy with it, but
when they try to tell others about the great toilet paper they found, those
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people only laugh and say, “Wait—you had to read a manual to use your
toilet paper?”

Now I’m going to add some additional factors to the toilet paper debate.

1. The lime green toilet paper is significantly more expensive than the
blue kind. The orange kind is still free.

2. People can break your toilet’s security and damage or make your toilet
paper unusable.

3. Occasionally, all types of toilet paper will stop working. However, green
and orange toilet paper do this less often, and can usually be recovered
within a couple of minutes. Orange toilet paper has the potential to be
wrecked beyond repair if used improperly, but will almost never break
of its own accord.

4. Once you have selected a type of toilet paper, you cannot use another
one with the toilet without going through an hour-long process that
converts it to a different type.

5. Blue toilet paper is much easier to find than green and orange toi-
let paper, and it’s very likely that your neighbor will have some blue
toilet paper you can borrow if you run out, but (due to their lesser
popularity), this is often not true with other types.

6. People who normally use a different type of toilet paper may have
difficulty using yours. People who prefer orange toilet paper are usually
used to all the different types, and will often have no problem. However,
users of orange toilet paper are quite rare.

So, summarizing:

� Electric blue toilet paper is very unreliable—it damages your toilet,
clogs it frequently, and sometimes even explodes. It often breaks and
can be difficult to repair, and malicious people can easily damage your
toilet paper. However, it is very common and you will nearly always be
able to find some, and nearly everybody can use it without any trouble.

� Lime green toilet paper uses different concepts than blue toilet paper,
so people may experience a slight learning curve changing from one to
the other. However, it’s just as easy to learn to use as blue toilet paper,
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and is significantly more reliable. Unfortunately, only a small number
of people use it, so your use of green toilet paper may annoy people,
and you may have difficulty finding more when you run out. It’s also
the most expensive type of toilet paper.

� Burnt orange toilet paper is uncommon, but it allows you to do basi-
cally anything you want with it. It requires reading a short manual to
familiarize yourself with its workings, and also needs a small amount of
time to install and master. However, once you have done these things,
you’ll think it’s great. It’s also completely free.

I think we can all agree on the fact that if popularity concerns were
removed, the blue toilet paper is an absolutely terrible deal and nobody
would use it. Lime green and burnt orange toilet paper would then be the
serious contenders. In this case, I would expect that roughly the same number
of people would choose to use green toilet paper as orange. People who are
willing to spend some money and don’t like learning things would choose
lime green toilet paper, while those who want to save their money and are
willing to work a little bit to have better control of their toilet would choose
orange toilet paper. In this situation, the issue of people having difficulty
using other types of toilet paper would also be diminished—with only two
types of toilet paper in use, and without one having a near-total monopoly,
people would learn the basics of how to use the other type properly, even if
they didn’t like it much.

* * *

If you didn’t get it yet, electric blue toilet paper represents Windows, lime
green toilet paper represents the Mac OS X, and burnt orange toilet paper
represents Linux. I may have exaggerated a bit on the instability of Windows,
but I honestly have never used another operating system that occasionally
chooses to melt down at an inopportune time and sit there with a guilty blue
screen facing me. Although occasional slow performance and bugs are a fact
of life with computers, Windows also seems to have more of them than any
other operating system. And it’s not like Windows has a terribly innovative
interface or anything else to particularly recommend it, either. It does, as
with blue toilet paper, have a wide user base (although more and more new
college students, for one, are beginning to purchase Macs), and is compatible
with nearly everything. Even that advantage is beginning to change, as more
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devices provide Linux drivers, more cross-platform software is developed, and
the amount of extremely useful free software (free as in freedom, not as in
free beer), much of which works on any system, increases daily.

What do you think? If you had to relearn everything you knew about
computers and you knew nothing about the popularity (or compatibility,
although as I mentioned, that’s beginning to be less and less important) of
operating systems, but only their features, which would you choose? Let me
know in the comments.



Part IV

Technical Geekery Quick Tips
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31: Finding Text on a Web Page
Quickly

Chances aren’t bad you already know the basics of this trick, but if you don’t,
it could save you a heck of a lot of time. If you already know the trick, I
have a couple of wicked cool shortcuts you probably don’t know.

(Disclaimer: I only had access to the Chrome and Firefox browsers while
writing this tip. I find that these are the best browsers available today; if you
don’t have one of them, check them out! If you are stuck using a different
browser, these tips will probably work anyway, but I can’t guarantee it.)

Part 1: Searching for Text on a Page

In every modern browser, you can quickly search for any text on the current
page by pressing Ctrl-F (“find”) and typing a word or words in the search
box. In most browsers you’ll be brought to the first result and all results will
be highlighted as you type.

Part 2: Cool Tricks

Now here’s the stuff you probably didn’t know:

1. Alternative Ways to Start Searching

If you don’t like the Ctrl-F shortcut, in most browsers you can use F3 instead.
In Firefox, you can also use a slash (‘/’). Note that this search works slightly
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differently from the normal search box (for instance, there is no “Find Next”
button).

If you use Firefox, there’s an even faster way to start searching if you set
an option. Go to Edit → Preferences (or Tools → Options depending on the
version of Firefox you use), select the Advanced tab at the top, and check
the box “Search for text when I start typing” (screenshot). Now when you’re
outside of any elements on a web page that accept text (text boxes, search
boxes, drop-down menus, etc.), Firefox will automatically start a quick find.

2. Continuing A Search (and more tricks)

Because of the differences between browsers, this section is really confusing.
So I made three versions, the Chrome version, the Firefox version, and the
both version. Pick the one that corresponds to the browser you use—if you
use both or neither, you probably want to plod through the both version so
that you know the differences. (If you use Internet Explorer or Safari or some
other strange and weird browser, take a look at the tips and experiment to
see which ones work for you.)

CHROME

Beginning a search is all well and good, but if the first result isn’t what you
wanted, how do you move on? When you start a search, you’ll get a couple
of buttons that let you move to the next or previous result. Clicking these
buttons with the mouse works just fine, but if you don’t have your hands on
the mouse or you’re clicking other places on the website with your mouse,
you may find that repeatedly returning to the buttons is a bit inefficient.

In this case, you need the F3 (Find Next) key. Pressing F3 will immedi-
ately jump you to the next result on the page. (If you close the search box
and then realize you need to keep searching, F3 will still take you to the next
result.) If you miss a result and need to go back, just use Shift-F3.

But F3 is kind of hard to reach, isn’t it? Just pressing Enter (and Shift-
Enter) does exactly the same thing while you’re in the search box. There is
only one small limitation: if you close the search box, Enter won’t reopen
it—only F3 will.

When you press F3, the text in the search box is highlighted, allowing
you to easily change the word you’re searching for if you need to.
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FIREFOX

Beginning a search is all well and good, but if the first result isn’t what you
wanted, how do you move on? If you start your search by pressing Ctrl-F
or F3, rather than /, you’ll get a couple of buttons that let you move to the
next or previous result. Clicking these buttons works just fine, but if you
don’t have your hand on the mouse or you’re clicking on other things while
searching, you may find that repeatedly returning to the buttons is a bit
inefficient. And if you started your search with /, you apparently can’t go to
the next result at all.

In this case, you need the F3 (Find Next) key. Pressing F3 will immedi-
ately bring you to the next result on the page. (If you close the search box
and then realize you need to keep searching, F3 will still take you to the next
result.) If you miss a result and need to go back, just use Shift-F3.

But F3 is kind of hard to reach. Just pressing Enter (and Shift-Enter)
does exactly the same thing while you’re in the search box. However, this
trick does have a couple of limitations:

When searching with / (but not when using Control-F), pressing Enter
will follow a link if the text found was in a link. If you land on a link and
want to keep searching, you need to press F3 instead of Enter. After closing
the search box, Enter doesn’t return to a search, only F3 does. If you don’t
think you can remember the differences between F3 and Enter, you can just
forget about the Enter tip and use F3 instead—slightly less efficient, but
simpler.

Both

Beginning a search is all well and good, but if the first result isn’t what you
wanted, how do you move on? If you start your search by pressing Ctrl-F
or F3 in Firefox, or anytime in Chrome, you’ll get a couple of buttons that
let you move to the next or previous result. Clicking these buttons with the
mouse works just fine, but if you don’t have your hands on the mouse or
you’re clicking other places on the website with your mouse, you may find
repeatedly returning to the buttons is a bit inefficient.

In this case, you need the F3 (Find Next) key. Pressing F3 will immedi-
ately bring you to the next result on the page. (If you close the search box
and then realize you need to keep searching, F3 will still take you to the next
result.) If you miss a result and need to go back, just use Shift-F3.
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But F3 is kind of hard to reach. In both Chrome and Firefox, just pressing
Enter (and Shift-Enter) does exactly the same thing while you’re in the
search box. However, this one does have a few limitations: In Firefox, when
searching with / (NOT when using Control-F), this will follow a link if the
text found was in a link. In both Firefox and Chrome, after closing the search
box, Enter doesn’t return to a search, only F3 does.

In Chrome, when you press F3, the text in the search box is highlighted,
allowing you to easily change the word you’re searching for if you need to.
Unfortunately, this doesn’t happen in Firefox.

In Firefox, when searching with /, pressing Enter while over a link will
follow it.

Part 3: Internet Explorer 7 Notes

While I won’t exactly consider this a complete test, I got a chance to try this
tip out in Internet Explorer 7. (Note that the current version is 9, so some of
this information might potentially be out of date considering your browser.)

Oddly, you can’t use F3 to advance to the next match—but it still works
to bring up search in the first place. Go figure. When you press Enter,
it seems that the search function finds the first match after where you
last clicked on the page (though that point isn’t actually displayed in the
browser). You can still use Enter to advance to the next match.



32: I Lost My Window!: Pulling
a Mischievous Window Back
On-Screen

Have you ever had the title bar of a window get stuck off the screen, so that
you can’t move it anymore? In Windows 7 it’s even possible to get a window
stuck under the taskbar, which is extremely aggravating—you can see it, but
you can’t click on it to move it back out! If you don’t think you’ll remember
how to deal with it, print out a copy of these instructions and you’ll know
what to do next time it happens.

If you’re not sure exactly what I mean, here are two screenshots: nearly
stuck1 and totally stuck2. (For this example, I got the window stuck on
purpose by dragging it entirely behind a panel, but it can happen accidentally
while moving windows or even sometimes when you open a program. In either
case, you see that the window is open but can’t be moved or even seen except
on the taskbar.)

The brute-force solution is to close the program and restart it. Unfortu-
nately, this sometimes doesn’t work, because programs often remember the
location their windows were at when they were closed, so that they can re-
open where you want them the next time. Even if this solution would work,
you might prefer not to restart the program.

Fortunately, there’s an elegant and simple fix. This tip works on Windows
and Linux; I haven’t tried it on a Mac, but it probably works. (By the way,
if you are using an operating system, like Mac OS X, that I say I haven’t
tested the tip on, and you try it and it works, please leave a comment.)

Switch to the window with the stuck title bar. To do this, you can click

1http://thetechnicalgeekery.com/tips/screenshots/lostwindow/lostwindow1.png
2http://thetechnicalgeekery.com/tips/screenshots/lostwindow/lostwindow2.png
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on a part of the window you can see (if there is any), or you can select its
taskbar button (so that it looks highlighted, something like what screenshot
2 looks like). Hold down the Alt key and press the spacebar. A menu should
appear with options for managing the window. Choose Move. Slide the
mouse away from the part of the screen the window is stuck in. The window
should move as if you were dragging and dropping its title bar. When you
get it to the location you want, click once. (Alternatively, you can use the
arrow keys to move the window.)

That’s all. Time to get back to work!



33: Big, Important Keyboard Short-
cuts

This article isn’t just about big, important shortcuts; it’s about Big, Impor-
tant ones. Unfortunately, I can’t make that clear in the title. But anyway,
if you don’t know these three shortcuts you’re probably wasting minutes of
your life every day. If you already do, I have a couple more that might be
new.

These shortcuts work almost everywhere—browsers, word processors, im-
age editors, financial programs, you name it. If you’re not sure if a program
supports them, try it and see—sometimes they’re not listed anywhere on the
menu but they still work.

Part 1: Easy Stuff

� Control-X: Deletes the currently selected text and places it on the
clipboard (known more conventionally as “cutting”).

� Control-C: Copies the currently selected text onto the clipboard.

� Control-V: Pastes the contents of the clipboard at the current cursor
point.

� Control-Z: Undoes the last action.

(Note: You can also cut, copy, and paste files in a file management pro-
gram such as Windows Explorer, the Finder, or Nautilus in the same manner.
In the case of files, a file you “cut” won’t be deleted until it’s been safely
pasted at the destination; if you copy something else to the clipboard by
mistake, the original files will be left unchanged.)
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I can’t tell you how many minutes of my own life I’ve spent watching
people slooowly selecting text, then moving their mouse all the way across
the screen to select Edit → Cut from a menu, when they could be done
pasting the text already. If you don’t already use these shortcuts, learn
them. Paste a sticky note on your monitor until you’ve got it down.

Control-Z is a nice extension to X, C, and V. All four keys are right next
to each other and can be easily operated with one hand while selecting things
with the mouse with the other. (Unless you use a non-standard keyboard
layout, like Dvorak. Then you’re out of luck on that particular front.)

Part 2: Slightly More Advanced Stuff

These aren’t really “advanced,” just lesser-known and less important. If I
could only teach someone 10 keyboard shortcuts, these probably wouldn’t be
among them—but they do still come in handy.

� Control-A: Select all text in the current document or text box.

Sometimes you need to copy an entire document and paste it somewhere
else (for example, into an email). Or you might have finished writing a
long comment in a text box on a website and want to save it yourself.
This shortcut saves you from spending a few seconds trying to highlight
a long document or blob of text.

� Control-Y: Redo an action.

If you undid your actions one too many times, the Redo command is
your friend. It’s an undo for the Undo command. A few programs use
the keystroke Ctrl-Shift-Z instead, but it works the same.

Confusingly, Redo also has another function in many programs (like
Microsoft Word)—if you just moved or typed something and your last
action wasn’t an undo, hitting Redo will repeat your last action.



34: Slashes and Backslashes, Oh
My

Slashes and backslashes can be difficult to tell apart—they look pretty simi-
lar, and to make matters worse they’re both used in describing the location
of a file. Hopefully you’ll have an idea of the difference when you’re done
with this article.

Part 1: Telling Slashes and Backslashes Apart

� This is a forward slash (often known simply as slash): /

� This is a backslash: \

If you have difficulty remembering which is which, try this:

1. Imagine the two characters forming a hill, like so: /\.

2. On the left side (forward slash), you go up the hill. On the right side
(backslash) you go “back” down the hill.

Here are some differences:

� The forward slash is located on the same key as the question mark.

� The backslash is located between the Enter and backspace keys and is
on a slightly longer key than normal. (On specialized keyboards, the
backslash can get moved to all sorts of places.)

� A forward slash is used for writing English text.

� A backslash is usually used only in computer contexts.
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Part 2: When to Use (Back)slashes

1. In filename paths:

Here are some ways of specifying the location of a file, several of which you
probably recognize:

1. http://www.google.com

2. C:\Windows\system32\progman.exe

3. /home/soren/code/scripts/m.sh

4. \\SERVER\Music

5. smb://SERVER/Music

(1) is a URL for a page on the World Wide Web. Web addresses always
use forward slashes. You can probably get away with typing backslashes and
have the page still load, but doing so is poor form and may occasionally not
work. Please don’t say “backslash” when reading a web address—it annoys
people who know about these things to no end.

(2) is a Windows file path. These paths always use backslashes. You can
supposedly use forward slashes if you want, but many programs will not ac-
cept paths typed with forward slashes.

(3) is a UNIX or Mac OS X style path. These always use forward slashes.
These systems will usually not accept backslashes, because the backslash is
used for something else (more on that in a minute).

(4) is a UNC path, used to specify the location of a device or file on a net-
work in Windows. This uses backslashes, though forward slashes will often
work.

(5) is another way of specifying a network resource, usually used on UNIX-
like systems. This uses forward slashes.

In short, Windows uses backslashes, while UNIX and Mac OS X systems
use forward slashes. Most importantly, Web addresses always use forward
slashes.
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2. Other Uses

Forward slashes can also be used:

� as a symbol for division (as in 6/3)

� to precede a command in a chat client or other program (as in /quit)

� to show italics when only plain text is available (like /this/)

� To indicate command-line options in Windows (dir/p)

Backslashes can also be used:

� as an “escape” character, to modify the meaning of the following char-
acter. This is a common feature on Unix and Mac OS X command
lines. For example, if a space would normally mean the end of a com-
mand or name, but the command or name contains a space, it would
be written like this: word1\word2

� to indicate integer division, where any fractional result is cut off (7 \ 2 = 3)

� to indicate that a line of text or program code does not end but should
be carried over to the next line (this is the first part of the line \
and this is the second part)

There are even more uses for these two simple characters in computing; if I
didn’t bore you out of your mind, you can check out Wikipedia:
http://en.wikipedia.org/wiki/Slash_(punctuation)

http://en.wikipedia.org/wiki/Backslash.

http://en.wikipedia.org/wiki/Slash_(punctuation)
http://en.wikipedia.org/wiki/Backslash
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35: Zooming In and Out In a
Zoom

Ever tried to make a picture, Word document, or web page display bigger or
smaller? You probably found it was an exercise in frustration because you
kept having to find the zoom options when you didn’t get the amount quite
right—but that’s because you didn’t know about this tip. Here are two ways
to quickly zoom in and out that work in nearly every program that supports
zooming.

Method 1: Using The Mouse

Hold down the Ctrl key, then turn your mouse wheel away from you to zoom
in or towards you to zoom out.

Method 2: Using The Keyboard

� To zoom in, press Ctrl - +.

� To zoom out, press Ctrl - - (Ctrl plus a hyphen).

� To return to 100% zoom, press Ctrl-0.
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36: What The Heck Does That
Key Do?

You know what keys I’m talking about. The ones that say things like Scroll
Lock, Break, and SysRq. When was the last time you pressed one of those
keys? Here’s how they got to be there, what they originally did, and if there’s
still anything you can use them for now.

Print Screen

The Print Screen key barely fits in this category—quite a few people know
what the Print Screen key does, and it’s the only one of these keys that I use
regularly. Originally, as its name suggests, the Print Screen key dumped the
contents of the screen to the printer. So why doesn’t it perform this handy
function today? Well, quite simply, graphical user environments. This key
was envisioned when text-based operating systems like MS-DOS were the
norm, and printing text was quite sensible. But when Windows came along,
the Print Screen key had to be deactivated in Windows—dot-matrix printers
and graphics don’t mix, and even if your printer printed graphics, that would
have been a lot of ink. (Dot-matrix printers are the really noisy kind that
operate by punching pins in the shape of letters. If you go to a few stores
with old cash register equipment today, you might still encounter a dot-
matrix receipt printer.)

But not being able to get a record of the current contents of the screen
wasn’t a good solution either, so the function was modified to copy an image
of the screen to the computer’s clipboard instead. This remains its function
today. If you’ve been reading along with this newsletter every week, you’ve
probably encountered a few of my screenshots—an common way to create a
screenshot is to press the Print Screen key, paste the image into an image
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editing program, and save it.
(Note: Most Macs don’t have a print screen key, but you can take a

screenshot by pressing Command-Shift-3.)

Scroll Lock

If you know anything about the scroll lock key, it’s probably that it makes
one of those little lights in the upper-right-hand corner of the keyboard come
on. But chances are good that you have never known what it’s for. If
you’re exceedingly (un)lucky, you might have experienced your cursor in
Excel refusing to move when you press the arrow keys. And that, it turns
out, is the solution to the mystery of Scroll Lock.

The scroll lock key was envisioned back when most computers didn’t
have mice. By pressing the scroll lock key and then the arrow keys, you
could scroll around your document without moving the cursor within the
document. Nowadays, with the advent of mice and scroll bars, this key is
almost entirely useless (except for making the little light light up). A few
programs still preserve the old behavior (like Excel), but by and large almost
no programs use the key, and you have no real reason to utilize it.

Insert

Those unlucky souls who have noticed their computer suddenly start typing
over text rather than inserting it probably know something about the Insert
key—namely, that it’s annoyingly easy to press by mistake. The purpose
of the key is to toggle insert and overtype mode—that is, when you type
more, whether the computer should insert it before text that comes after, or
whether the text after it should be replaced as you type. (If you’re confused,
try it: fire up Word, type a few words, press Insert, and try inserting text
between the words.)

You probably can’t think of any uses for overtyping text, and by and large
there aren’t any, but I can think of a few. For instance, if you have some text
in Word that will wrap to the next line and totally mix up the formatting,
or you’re filling out a form where adding extra spaces could mess things up
very quickly, turning on Insert will let you change or fill in the space without
adding extra characters.
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Pause/Break

Fortunately, pressing this key does not break your computer. In fact, chances
are very, very good that pressing the key will do nothing at all. Believe it or
not, the origin of the key dates back to the days of the telegraph. Telegraph
keys had a switch that would short the contacts of the key, generating a
continuous signal. This switch would be set anytime the telegraph was not
in use—this way, when the operator was ready to send again, he could turn
off the switch and thereby alert the receiving party that he was about to
send. (Additionally, if the signal was broken and no message arrived, they
would know there was a problem with the line.)

When teletypewriters came into common use (they were used for a time
to control early mainframes), the Break key was created to emulate this
functionality. Pressing the key would cause the system at the other end
to terminate a program, prepare for a login, or something similar. (When
controlling a teleprinter at the other end instead of a computer, the printer
would generate a continuous series of punches or DELETE characters, which
was sometimes used to make a loud noise and alert the operator.)

So is there anything you can do with the Break key? Well, maybe. If you
ever run MS-DOS programs, pressing Ctrl-Break may terminate a program.
When your computer is beginning to boot and doing the POST (Power-On
Self Check, where you see the computer’s hardware or manufacturer’s logo
displayed onscreen), you may be able to freeze the output with Pause. But
the only thing that most users are likely to be able to do with the Break key
is to open the System Properties screen on a Windows computer, which you
can do by holding the Windows key and pressing Break.

SysRq

I’m tempted to pronounce this “sys wreck” and say that it makes your system
explode. But it actually stands for “system request,” and goes down in
history as something that was completely superseded and outdated about
twenty years ago, yet still remains a standard feature of PC keyboards. It’s
usually combined with the Print Screen key and accessed by holding down
Alt before pressing the key. The key was originally introduced by IBM as
a way to switch between operating systems. Since then it has had. . . well,
basically no use at all. A tiny number of systems use it as a sort of “panic”
signal, to trigger a hard reboot or terminate a program.
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The key does have one useful function on Linux computers. There’s a
function called the “magic SysRq key” that can be used to terminate the
entire desktop environment (essentially logging you out immediately) or per-
form various other debugging functions. The key has absolutely no use what-
soever to Windows users.



37: Six Handy Browser Short-
cuts

Want to know a quick way to scroll down the page without the mouse? Or
reopen a tab you closed by mistake? Here are six ways to move around your
browser more efficiently.

1. Press the spacebar to scroll down one screen. This allows you to read a
page without having to keep scrolling the mouse or pressing the arrow
key. About two lines from the previous page will be left on the new
page so that you don’t lose your place.

2. Open a new tab by pressing Control-T. It’s sure a lot easier than trying
to hit the little plus button next to the tabs.

3. Open a new window by pressing Control-N. You probably don’t need
a new window very often, but it’s an easy shortcut to remember for
when you do.

4. In Chrome, open a new incognito window by pressing Control-Shift-N.
(In Firefox, enter private browsing mode by pressing Control-Shift-P.)
This doesn’t save history, cookies, or anything else, so you don’t leave
any traces of where you’ve been when in private browsing mode. (Well,
the web server can still collect information about your visit. But your
computer stays free of any information.)

5. Press Control-L to move your cursor to the address bar. This can save
you reaching for the mouse when you’re ready to visit a new site. It’s
especially handy in Chrome, where you can easily start a search from
the address bar.
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6. Press Control-Shift-T to reopen a tab you just closed. This is really
nice when you accidentally close a tab, or if after a few minutes you
realize you weren’t really done with that reference page. It sure beats
having to open your browsing history and find it again.



38: How To Plug In A USB Ca-
ble The Right Way The First
Time

Ever gone to plug in a USB cable, couldn’t get it in, and flipped it over and
tried again, only to discover that you had it the right way the first time?
What’s that? You do it every day? Fortunately, this is a surprisingly easy
annoyance to fix.

1: Getting The Cable The Right Way

Ever noticed that nearly all USB cables have a little USB logo on one side
of the plug? That logo is on the same side of every USB connector—unplug
one of your USB cables and see for yourself. Flash drives, unfortunately,
don’t have the logo; however, this can be rectified by memorizing which way
is which, or you can put a little sticky dot, Sharpie mark, or correction fluid
on that side.

2: Which Way Do I Plug It Into the Port?

There aren’t any guidelines that are right 100% of the time, but most equip-
ment does conform to a couple of standards. On laptops, the logo will face
up, and on desktops it will face the far side of the case (the side that is
furthest away from the ports). On the sides of monitors, the USB logo will
face you. As for everything else, like hubs, the best thing to do is to try it
and see.

Rather than remember all these rules, I take a labelmaker, print out
a neat label that says something like “LOGO LEFT”, and stick it on my
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hub/case/other device. That way I don’t have to think about it.



39: Tips & Tricks for Filling Out
Forms

Ever had to fill out a really long form? A lot of people waste large amounts
of time working with forms because they don’t know a few simple shortcuts
(most importantly, the Tab key!) Here’s how to get it done more quickly and
less painfully.

0: Screencast

I’m trying something new this week—a screencast. If you don’t know, a
screencast is a video of someone’s screen as they perform some task (in this
case, purchasing a cash register online), usually with a voiceover explaining
what’s going on. I’d suggest you read the article first, but I think checking
out the video1 afterwards will probably help you see what I’m talking about,
and perhaps put the information into a form that will be a little bit easier
to apply. And above all, if you take only one thing from this article, let it
be this: Use the TAB key. It will save you hours over the course of your
lifetime.

1: Terminology

Before I can cover how to move through a form quickly, you probably want
to know some terminology—if you already know it, feel free to skip over this
section. So here are the elements that often appear in forms (all these are in
the screenshot, so you can reference it if you need to):

� Text Box: You probably already know what this is—a (usually white)

1http://www.youtube.com/watch?v=7kd9ZzV-q0g

147

http://www.youtube.com/watch?v=7kd9ZzV-q0g


148 39. TIPS & TRICKS FOR FILLING OUT FORMS

box that you can type text into. Usually you can type whatever you
want into here, though some text boxes may have validation—for in-
stance, an email address has to contain an at sign and a dot, and the
CAPTCHA code where you have to type in the funny letters to prove
that you’re human has only one correct answer.

� Drop-Down Menu (or simply drop-down): A (usually gray) box with a
little arrow on one end. When you click on it, a list pops open and you
can scroll through it and select one of the choices. These are usually
used when there are a lot of options, but sometimes form designers
might put short lists in a drop-down.

� Check Box: A small square box; when you click on it, a check appears
or goes away. This is (usually) for on/off and yes/no questions only.

� Radio Buttons (or option buttons): Little round buttons, typically used
for short lists of options. When you click one of the radio buttons, any
previously selected one gets unmarked.

� Field: Any one location asking you to enter data (i.e. “first name”,
“state”, “telephone number”, and so on).

In addition, forms can contain text, lines, and pictures, but you can’t enter
any information with these.

2: Moving Around A Form

Your TAB key is your biggest friend when filling out a form. It will advance
automatically to whatever the creator of the form has defined as the next field
(hopefully this is an order that makes sense to you!). If you accidentally skip
a field or need to go back and change something, you can press Shift-TAB.
When you use the key to move into a text box that already has something
in it, it will usually highlight any previous text so that you can just start
typing over it (be careful that you don’t accidentally delete anything).

When you’re moving through a form that has a text box, then a series of
check boxes, then another text box, you can save a fair bit of time (and a lot
of effort) by avoiding the mouse, because you don’t have to keep switching
from mouse to keyboard. If you use the TAB key and the following tips, you
should have no reason to touch your mouse. (If you’re filling out a form that
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consists entirely of check boxes, drop-downs, and radio buttons, such as a
survey, then these tips are probably a waste of time for that particular form.)

The next sections tell you how to deal with each individual element; they
assume that you pressed Tab to move to and select that element.

Text Boxes

There’s not much to say about these—the biggest factor here is your typing
speed. Unfortunately there are no magical efficiency-improving text box
tricks.

Drop-Down Menus

There are several tricks with drop-down menus. Don’t even think about
reaching for your mouse to use a drop-down menu. All you really have to do
is start typing, and the menu will scroll to that choice. For instance, if you’re
asked to fill in your state, you don’t have to scroll through the entire menu
hunting for your state—instead, just type the first couple of letters and it
should be selected for you.

If you aren’t sure what options are in the drop-down menu (and therefore
can’t type the first letters of it), just press the spacebar. This will open the
drop-down menu so that you can see the options. You can then start typing
the option you want.

If all the choices don’t fit on the screen, you can use the arrow keys and
Page Up/Page Down keys to see the rest of the list. If you select the choice
you want with the arrow keys (instead of typing to move to it), just press
Tab twice to close the drop-down and move to the next field. (Enter and
then Tab also works, but double-tabbing is faster.)

Check Boxes

Check boxes are very simple to manipulate—to turn them on or off, just
press the spacebar. If there’s more than one, just press tab and repeat.

Radio Buttons

Radio buttons are funny because they have a different state after you’ve
selected something once—before you choose a button, nothing is selected,
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but after you make a selection it is impossible to return to having nothing
selected.

Unlike other sets of elements (like multiple check boxes) radio buttons are
selected as a set when tabbing, so pressing Tab while the first radio button
is selected will tab to the field after all the radio buttons, rather than to the
next radio button.

To select the first radio button, you can press the spacebar. To select any
others, simply use the arrow keys, and buttons will begin being selected as
you press the keys.

Submitting

When you finish entering your data, you can press Enter to send it. At this
point, Murphy’s Law states that the site will usually return an error and
require you to retype some or all of the information again (often because you
missed the little tiny button that states you agree to the terms and condi-
tions that have been read by approximately five people, or else because you
mistyped the eye-straining verification code). If it’s only one field, clicking
on it and fixing it is probably best, but otherwise you can reuse the tips
above.

If you haven’t seen the screencast yet, I suggest you watch it now.



40: Using Your Middle Mouse
Button in Your Browser

Most people don’t even know what a middle mouse button is, let alone how
to use it. But it is enormously useful. Here are a few ways to deal with tabs
in your browser much more easily.

But I don’t have a middle mouse button!—That’s what 90% of people
I inform about this tip say. Of course, they’re wrong—unless you have a
really old mouse, you have a middle mouse button. To middle-click, you
just press down on the scroll wheel. (If you have a laptop, you can usually
emulate a middle-click by pressing down the left and right touchpad buttons
simultaneously, and if you have a Mac with one mouse button you can hold
down the Command key and click.)

A disclaimer: I only had access to the Chrome and Firefox browsers while
writing this tip. While I personally believe you should be using one of these
two browsers, I understand you may not be, in which case these tips will
probably work but I can’t guarantee it.

1: Closing a Tab

To close a tab, you could aim for the little tiny x button in the corner of the
tab. Or you could just middle-click anywhere on the tab and save yourself a
couple of seconds every time you close a tab.

2: Opening a Link in a New Tab

I couldn’t live without this trick. Sometimes you’re researching a topic and
come across a link that looks interesting, but you want to be able to easily
return to the current page. Don’t follow the link (and maybe several more
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links in the same fashion) and then click the Back button a few times—this
is a lot of wasted effort, and you might even have trouble figuring out which
page of the 5 you just visited was the original one. Instead, middle-click the
link, then switch to the new tab. When you’re done with the new page, you
can simply close the tab to get back to where you were.

This is also really nice if you’re reading a page and see something that
looks interesting, but you don’t want to stop reading the page you’re on to
look at it. Instead of trying to remember all the links you wanted to look
at, middle-click the link, then move to that tab when you’ve finished reading
the original page.

I also use this trick when visiting news sites: I scroll through the list
of available articles, middle-click all the ones I want to read, then close the
home page. In this way I can easily read all the articles I’m interested in
without having to click the Back button, wait for the page to load, and find
a new article each time.

3: Opening the Previous Page in a New Tab

Tip #2 is all well and good, but sometimes you don’t realize that you still
needed a page until after you click a link on it. In this case, you can middle-
click the Back button, which will bring up the page you were just visiting
in a new tab. This option is even kind enough to duplicate your browsing
history in the new tab, so you can still click Back and Forward in the new
one (unlike if you opened a link in a new tab, where the new tab starts with
no history).

4: Duplicating a Tab

If you want to duplicate a tab, you can middle-click on the Refresh button,
which will open a new tab pointed at the URL of the current page. In prac-
tice, usually this tip is unnecessary because you can use 2 or 3 to accomplish
the same thing.



41: Two Shortcuts for Working
With Files

Ever opened up a really, really long list of folders and hunted through the list
trying to find a folder or file? Or maybe the same thing happened on your
desktop—you knew the name of what you’re looking for, but you couldn’t
see it. Here’s a better way.

Tip 1: Jump to a File or Folder by Typing its Name

This trick is so simple you’ll probably be surprised you never knew about it.
If you know the name of a file or folder located in the folder you’re currently
browsing, but you can’t see it, simply click once on any file or folder you can
see, then start typing the name of the folder. You’ll be moved to the folder
as you type. (Don’t stop typing for more than a second or so, or the search
will start over.)

This works in a File → Open dialog box, in a Windows Explorer/Finder/Nautilus
window, or on your desktop, in all operating systems.

Tip 2: Rename a File Quickly

Renaming a file can be a little bit annoying sometimes, especially if you have
to rename quite a few files. You can right-click it and choose Rename, or
you can click twice slowly on the name of the file. Either way, the process
requires some clicking, and if you’re renaming a bunch of files you have to
keep switching between the keyboard and the mouse.

Instead, just select the file and press F2.
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42: A Little Refreshment: Reload-
ing the Current Page

If a website has changed, you often don’t see the changes right away. A few
sites, such as Facebook, do dynamically update the website, which usually
makes this tip unnecessary. However, occasionally Facebook and similar
websites do fail to update, and most websites will still need manual refreshing.
Here’s what to do if you suspect the website on your screen isn’t the most
recent version.

1: Refreshing a Page

The Refresh button has been moved all over the screen by many major
browsers lately, but it’s usually either next to the Back and Forward buttons
or at the end of the address bar.

To reload the page, just click the button. Most of the time this will load
the most recent copy of the page with no problems.

2: Really Refreshing a Page

Sometimes your browser thinks it’s smarter than you, and when you push
Refresh it just loads a copy from your computer’s cache. (The cache stores
copies of frequently accessed Web resources on your computer so that pages
can be loaded more quickly.) So even after you’ve pushed Refresh, you may
not actually have the site’s most recent version.

If you’re suspicious that you still don’t have the latest version of a site,
simply hold down the Ctrl key while hitting Refresh. This will disallow
loading from the cache and force a full copy of the page to be downloaded
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from the Web. (A few browsers use Shift instead, so if it still doesn’t work
it can’t hurt to try that as well.)

3: Keyboard Shortcuts

I’m a big fan of keyboard shortcuts. I use Refresh several times a day, so
I get really annoyed by having to try to click the button every time I need
it, especially since it’s in different places in different browsers. So the handy
shortcut for Refresh is F5. (This also works in combination with Ctrl; see
section 2.)

If you don’t like F5 for whatever reason, a few browsers also accept
Control-R.

4: Refreshing Other Stuff

The refresh concept (and the F5 keyboard shortcut) also works for folders on
your computer. If you save a new file in a folder, for example, but currently
have a window open showing that folder, the folder may not display the new
file. Pressing F5 will tell it to look for files again, thus showing your new
file. If your desktop isn’t displaying changes, you can use this trick there too:
click anywhere on the desktop, then press F5.



43: Switching Quickly Between
Windows

Here’s another shortcut that everyone should learn. It’s a godsend if you’re
switching repeatedly back and forth between two windows, and useful even
if you aren’t.

1: Alt-Tab

Pressing Alt-Tab will allow you to switch windows to the most recently used
window. If you continue to hold down Alt after releasing the Tab key, the
window switcher will remain open and allow you to select any other window
as well.

If that sounds confusing, try it out, and it will become clear immediately.
(Mac OS X users: Use Command-Tab instead of Alt-Tab.)

The behavior of Alt-Tab is actually a lot more complex than it looks—if
you’re interested in the details, see the Wikipedia article. But the main thing
you should remember is that it lets you easily toggle between two windows.
Next time you have to copy and paste text several times between windows,
try pressing Alt-Tab instead of clicking each of the windows in turn, and
keep your hands off the mouse!

2: Similar Shortcuts

On Windows Vista and 7, Windows-Tab (the Windows key is often la-
beled with a flag icon) will do roughly the same thing, but display a fancy
Rolodex-style preview of the window. On earlier versions of Windows, press-
ing Windows-Tab will select each program on the taskbar in turn; you can
press Enter to select one.
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Alt-Tab is really handy in keyboard macros, which I’ll probably write an
article about later on.



44: How to Touch Up Your LCD
Monitor

Is your monitor starting to get a bit old? Does it have some scratches and
spots on it? Yeah, so did mine. In fact, I was about ready to get rid of
it. And then I read something that provided the following novel method for
fixing up scratches in your screen: a pencil eraser.

Yes, you read that right. If your monitor’s more than a couple of years
old and it has any kind of spots or scratches on it, you owe it to yourself to
give this method a shot.

You only need four things:

� a clean cloth (preferably microfiber, the kind they sell for cleaning
glasses or monitors)

� a few cotton balls (if you don’t have any, a second cloth will do in a
pinch)

� rubbing alcohol (pour a little out into a bowl so you don’t contaminate
the rest of the bottle)

� a clean pencil eraser

Here’s how:

1. Clean off the pencil eraser if it’s been used to erase anything. Just
rub the outer layer of it off until you don’t see any smudges on it
anymore. Smashing graphite particles into your monitor isn’t going to
help anything.

2. Open up your web browser and type about:blank in the address bar,
then press F11 to display the page full-screen. This will give you a
blank white screen. (You do this so you can see all the spots easily.)
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3. Dip a cotton ball into the rubbing alcohol and clean off the monitor
with it. Reportedly, this is the method that manufacturers use to clean
the displays as they reach the end of the assembly line; regardless of
whether that’s true or not, it works well.

4. Wipe the monitor dry with the cloth.

5. Take the eraser and carefully rub it onto all the scratches and spots,
and watch as they magically disappear, or at least get better. It’s fine
to use some pressure as long as you work deliberately and don’t smash
the monitor.

6. Blow off the eraser dust if there’s any left, and clean the monitor again.
You can repeat steps 2–6 as many times as you want, until you’re
satisfied with the result. It may take a couple of runs to completely
get rid of the problems.

7. When you’re done, press F11 or Escape, depending on your browser,
to get out of the full-screen mode.

Of course, this method isn’t going to work for horrible gashes down the
center of your monitor, but for relatively minor blemishes, it works like a
charm. I had a damaged spot that was about an inch square, and after doing
this I can’t even see it anymore.



45: The Escape Key: Getting Out
of Stuff

“Yeah, if you press Escape enough times, you’ll escape from your problems.”1

Nice try. But even though it’s not really a solution to everything, you can
still get out of quite a few things using your Escape key.

� If you open a dialog box you don’t want, just press Escape to close it.
For instance, if you choose File → Open in Microsoft Word and realize
you don’t want to open a file after all, you can just press Escape to
close the window instead of looking around for the cancel button.

� If you start dragging a file or text from one place to another and realize
you don’t want to move it after all, or you started moving it to the
wrong place, pressing Escape will release whatever you’re dragging and
put it back to its original location.

� If a website is hung up or you accidentally browsed to it and don’t want
to wait for it to load, you can press Escape to stop it from loading. (You
can follow up with F5 to reload it if appropriate, as discussed in tip
42.)

� If you open a menu (or right-click) and you don’t want it, Escape will
close all the menus quickly.

� If you’re in a PowerPoint presentation and want to stop it before the
end, pressing Escape will end the show.

1I said this a few months back when someone was in a sticky situation in a computer
game and another player had told him to press Escape to clear a message box. Nice try!
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� There are more uses that I didn’t mention—you can use it almost any
time you want to cancel an action you’re in the middle of taking. If
you’re not sure if Escape will work, feel free to try it—pressing Escape
will never cause anything particularly untoward to happen (unless you
just spent five hours filling out a dialog box, in which case you have
other problems).



Part V

Appendices
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Appendix A: Keyboard Shortcuts

Useful shortcuts have been a staple of all three of my tips publications, so
here is a list of the most useful or important ones (in my opinion). Most of
these have been referenced somewhere in my tips. If they have been, there’s
a page number where you can go to learn more about it.

If you don’t know these shortcuts, you really should learn them.
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Keystroke Effect See page
Alt-Tab Switch between open programs. 157
Alt-F4 Close the current program. 20
Ctrl-Tab Switch between tabs (in browsers) or documents

(in word processors).
Ctrl-F4 Close the current tab (in browsers) or window (in

word processors).
Ctrl-W Close the current window (sometimes).

Ctrl-F Find something on the current page. 125
Ctrl-A Highlight the entire document or page. 132
Ctrl-S Save the current document. Works in both word

processors and browsers.
F12 Save As. 36

Ctrl-X Cut. 131
Ctrl-C Copy. 131
Ctrl-V Paste. 131

Ctrl-Z Undo. 131
Ctrl-Y Redo. 132

Ctrl-Alt-Del The infamous “three-finger salute.” Opens a
screen of options for logging off or ending unre-
sponsive programs.

46

Ctrl-Shift-Esc A faster way to get to the “ending unresponsive
programs” part of Ctrl-Alt-Del.

46

F1 Get help. 36
F5 Refresh the page. 155
F7 Do a spell-check. 36
F11 Make your browser full-screen. 67

Tab Move between fields in a form. 147
Escape Get out of dialog boxes, stop dragging stuff you

didn’t mean to start dragging, and more.
161

Print Screen Take a screenshot and copy it to the clipboard. 139



Appendix B: Searching Google

This was originally published as a special edition of the Technical Geekery
Tips: January/February 2010. (It was actually not published until Septem-
ber 19, but I apparently still hoped to catch up at that point.) However,
Google changes rapidly, and so this is not identical to that—it’s an updated
version.

About 95% of the time, if you have just about any question, you can go
to Google and type in the first couple of words that you think of, and in a
couple of seconds you have your answer. But sometimes it doesn’t work out
quite that way. This guide tells what you should do when you don’t get what
you wanted, and some more tips and things you didn’t even know Google
could do.

A note on syntax

Because of all the different special characters that have meaning in searches,
I’m going to set all my example searches in monospace. Any special charac-
ters should be interpreted as an intentional part of the search.

Also, it should be noted that Google is always changing, and some of this
information may be incorrect now or in the future. (This is already a second
version.) Additionally, Google is so complicated that it sometimes confuses
everyone, even when they have all the rules down and think they know it all.
Things you really didn’t expect or seem to not follow the rules may show up.

Basic Tips

� If you don’t get what you want right away, start by changing a cou-
ple of words around. If your initial query was find Windows desktop
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folder, for example, try locate Windows desktop directory instead.

� Moving words around might change your results too, say, Windows

desktop directory location. (Even Windows desktop directory

locate might come up with different results.)

Mechanical Stuff

� Google doesn’t actually have to search for every word in your query. If
you type, say, Lucid Lynx (which is the latest release of Ubuntu Linux
as of this writing, if it sounds familiar), the top results will contain both
lucid and lynx. However, once it runs out of those results, or comes
up with none, it won’t end the search—instead, it’ll show pages with
only one of the terms. If you’ve ever gotten a page of really irrelevant
stuff, this is probably why. In addition, Google automatically searches
synonyms of your query—say, childcare when you typed child care.
Most of the time, this isn’t a big deal, but sometimes you want to
be sure you only get all of the words, and you don’t want to search
synonyms.

The fix: Surround each word you want to search exactly with “quo-
tation marks”. Google claims all words have to be included anyway,
but experience tells me not to believe it. (The Google help pages even
admit this, with the note “A particular word might not appear on a
page in your results if there is sufficient other evidence that the page
is relevant.” Apparently, my definition of “relevant” is different than
Google’s.1

� Terms don’t necessarily have equal weight, although they often do. The
first terms are sometimes emphasized, although the difference may well
be unnoticeable, since the only times you worry about it are when all
the pages are very relevant (or all the pages are not relevant at all).
If you don’t find what you’re looking for, moving the terms around is
worth a shot, as is rewording some of them.

� Terms don’t have to be in order, and they can be anywhere on the
page. This means that wildly irrelevant results sometimes appear.

1You used to be able to use a + in front of the word for this, but Google removed
support for this syntax recently.
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For instance, I run a Google Alert (which is basically an automatic
Google search) on windows 8 in order to keep track of the development
of the next version of Windows. This search occasionally brings up
phrases like 8 years ago, some windows were broken... or Using
Microsoft Bob 8 times on Windows 95 can be a problem.

The fix: If you want all your terms to be in order and together, put it
“in quotation marks.” However, quotation marks should be used only
for a good reason; if you put every search you make in quotation marks,
you’re going to miss perfectly good results that happen to have a word
or two slightly different.

� Google strips away connecting words, like and, to, the, and so on. This
can sometimes lead to unexpected results. For instance (for lack of a
better example), say I wrote a book about my online presence called
The Life and Death of scorchgeek. If I simply typed in The Life and

Death of scorchgeek into Google, the parser would strip that down
to life death scorchgeek, which may well not be what I intended.

The fix: If you don’t want your connecting words to get messed with,
put them in “quotes”.

� Google is not case-sensitive, and cannot be made to respect case. But
when were you planning to use that anyway?

� Google does not support any form of wildcards or regular expres-
sions. So I can’t type, for instance, the web* to get the webpage,
the website, the web page, etc. It should be noted, however, that
Google does automatically expand many words, so that win may be
expanded to winning, won, and so on, which is almost a substitute
(although it doesn’t offer you nearly the same level of control).

� If you’re seeing tons of results about something irrelevant, and they
have a common word or phrase, put that word or phrase in quotation
marks, after a minus sign, like so: -"buy today!". Note that unlike
some search engines, typing NOT will not have the same effect as the
minus sign; in some other search engines, annoyingly enough, exactly
the reverse is true. You can use the minus sign with as many words
or phrases as you want; just put a separate minus sign in front of each
of them. (Note: There needs to be a space before the minus sign, and
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no space after it, or Google interprets it as a hyphen rather than an
exclusion, like anti-spyware.)

� Google will change your search around and, sometimes annoyingly, dis-
play pages that don’t actually match your search query, if it “finds sig-
nificant evidence the page is relevant.” I don’t think anyone at Google
has published their definition of “significant evidence” yet, but it’s cer-
tainly different from mine. Sometimes, this feature is nice; other times,
it’s extremely annoying—if I type something in, I want to have only
things that exactly match my query show up.

The fix: Using quotation marks judiciously, perhaps moving the quotes
around if you don’t find what you’re looking for immediately, usually
does a good job of searching only your exact query.

� There are always exceptions, and Google does a remarkably good job of
analyzing your query and figuring out when it should break the rules.
For instance (borrowing examples from the Google help pages), C++ is
a programming language, not C and extraneous punctuation; the who

refers to a band, and Google will avoid stripping the entire query.

� Punctuation marks that are part of recognized exceptions, like C++, are
not ignored, nor are dollar signs, hyphens, or underscores. All other
punctuation marks are removed.

More advanced operations

There are a lot of operations available, and many more which I haven’t
mentioned and which are practically undocumented. So I’ve tried to order
this list with the most useful tips first. If you are told to use an operator
with a colon, you generally don’t want to leave a space between the colon
and your search terms—it sometimes works with a space and it sometimes
doesn’t, and I haven’t been able to figure out the logic, so I always leave it
out.

� If you want to search only a specific website, because you know it’s on
that site but you don’t know how to get to it (I do this all the time
with news articles), or the site has a lousy or nonexistent search box,
use the site: operator. Example: site:www.slashdot.com
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� If you remember a good part of a phrase, but don’t know some of the
words in it, an asterisk (*) matches any single word. This comes in
real handy if you’re thinking of a saying or cliche and can’t remember
the entire thing. (Note that Google does not support conventional
wildcards, where a * would mean zero to infinity characters.) Example:
Whatever can go * will go wrong

� If you want the definition of a word, use the define: operator. If you
click the “More Info” link, Google will show a nicely formatted list of
different dictionary websites’ definitions. This is really nice because I
often find that one dictionary lacks important aspects of a definition,
but several read together generally give a very good impression of the
word, and allows you to mix and match parts if you need to write your
own definition. Example: define:example

� Need a quick calculator? Just type in your equation, and Google will
solve it easily. Logarithms, parentheses, trigonometric functions, and
so on are all handled. ^ does powers, and % does modulus (remainder).
It respects order of operations, so you can probably put in some fairly
complicated equations. That said, if you’re doing serious math, you’re
better off going to Wolfram Alpha (http://www.wolframalpha.com/),
which has nice formatting features and can handle serious calculus and
data manipulation. Example: 8+5*(4+3)

� Need to convert units of measure? Just type what you want to convert
and the units you want to use into the search box, and unless it’s some-
thing really obscure or nonsensical (like 18 feet in hours), Google
should have no problem. It even supports metric prefixes (10 pounds

in nanograms) and silly conversions (18 light-years in inches).
It can expand most common abbreviations, if you hate typing that
much. Of course, if you make a mistake and don’t get any results,
you’ll land on a normal search page, which is unlikely to have anything
remotely relevant. Sometimes the autofill feature will give you the an-
swer before you’re even finished typing. Example: 56 tablespoons in

cups

� You can convert number systems the same way. You’re unlikely to
ever need to convert a number to binary or hexadecimal, but you never

http://www.wolframalpha.com/
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know. More down-to-earth is a Roman numeral converter. (The key-
word for converting to normal numbers is decimal, which took me a
couple of minutes to figure out.) Example: XXII in decimal

� You can even convert currencies, with updated exchange rates. There
is a disclaimer that states that Google makes no guarantee on its being
up-to-the-minute, so you probably wouldn’t want to bet your company
on it, but otherwise it should work fine.

� Ever gone to Google, run a search, and found that the website you
clicked on does not contain what you searched for? Even more annoy-
ingly, find that the page is down or has been deleted? A little-known
fact is that page (sometimes with the content you were missing, if it’s
been deleted from the website for some reason) is still stored in Google’s
cache. To get to it, you can click the tiny “cache” link underneath the
main link in the search results. If you already know the website is in the
cache but not in its original location, you can use the cache: operator
to get directly to the page. Example: cache:www.google.com

� If you want a quick weather forecast, use the weather: operator. (Actu-
ally, in this particular case, you don’t technically have to use the colon;
just weather will do just as well.) Simply typing weather will cause
Google to attempt to guess your current location through some undis-
closed algorithm which I suspect is based on your IP address, which
uniquely identifies your computer or network on the internet and often
gives the location of your ISP. For better accuracy, type your location
afterwards. Example: weather:seattle washington

� If you know the file type of the file you’re looking for (say, a PDF, or a
JPEG), use the filetype: operator. Of course, if you’re looking for pic-
tures, you’d be much better off using Google Image Search. Example:
filetype:pdf "the technical geekery"

� If you want to see pages that link to a particular website, use the
link: operator. (Word to the wise: This seemed to me to return ir-
relevant and strange results; for instance, my query below returned
no results, but I know for a fact there are a fair number of links to
my website, and link:www.google.com gave results that didn’t make
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much sense. I would say I was wrong about the operator, but us-
ing it from Advanced Search confirmed that I was correct.) Example:
link:www.thetechnicalgeekery.com

� If you want to see pages that Google thinks are related to a site, use
the related: operator (oddly enough). “Google thinks” is a key phrase
here; sometimes it works well, and sometimes it doesn’t. For example,
related:google.com returned other search engines, related:bit.ly
returned other URL shortening services, and so on. But related:thetechnicalgeekery.com
returned seemingly random results. Example: related:www.snipurl.com

� Many of the above options, if you want to cut down on the ones you
memorize, can be accessed from the info page for that website, accessed
with the info: operator. Strangely enough, it only works for some web
pages, and of course you have to know the URL to be able to use it.
Example: info:www.google.com

� If you happen to know a phrase that’s in the website’s title (the text
that appears in the title bar of the window and in bookmarks), you can
use the intitle: operator to narrow your search quite dramatically—in
my test, there were only four results, and they were all my web page.
Example: intitle:"the technical geekery"

� If you want to search for a range of numbers, there’s no need to type 2
OR 3 OR 4, and so on for as long as you want, or just put in a * and
get some irrelevant information. Instead use a .. between the numbers
to search for any of those numbers in that position. Note that this is
not changed by placing the term in quotation marks. Example: 2..20

� If you know part of a URL, you might be able to find the site with the
inurl: operator. Strangely, I noticed that there was at least one URL in
my example that didn’t actually contain the string thetechnicalgeekery.
Example: inurl:"thetechnicalgeekery"

Advanced Image Search

When you’re searching images, you might want to filter based on license (can
I freely reuse this picture?), or size (is this going to fit on my PowerPoint
slide?). Instead of memorizing a bunch of operators for something most
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people use very rarely, Google has you simply go to the Advanced Image
Search page. There is an advanced normal search page, accessible by clicking
the link to the right of the main search box, but it includes only a small subset
of these tips, and you can use all the important features directly from the
search box. That said, if you’re still learning, or you need to sort by date
(oddly enough, you must go to Advanced Search to do that), feel free to
use it. You can access Advanced Image Search at http://www.google.com/
advanced_image_search?hl=en.

http://www.google.com/advanced_image_search?hl=en.
http://www.google.com/advanced_image_search?hl=en.


Appendix C: Quotations

I wanted to fill up a little bit of space, and I find these quotes amusing. I
have them in several places: some are taped up on the upper walls of my
room, some may randomly appear when I open a new terminal window on
my computer, and others might just be in my all-encompassing Random
Thoughts document, a massive repository of clippings. A number of them
originally came from Rinkworks’ Computer Stupidities, an awesome website:
http://rinkworks.com/stupid.

� I once received this error upon booting Windows: “There is no disk in
the drive. Please insert a disk into \Device\Harddisk4.”

� I also got this error after Windows crashed: “A system call that should
never fail has failed.”

� I got this one when clicking a menu option in the game FreeCiv: “Error:
No error.”

� And. . . “Error: The operation completed successfully.”

� This is a common fault on many, many computers: “Error: No key-
board. Strike F1 to continue.”

� After an hour of troubleshooting on the phone: “Oh, by the way, light-
ning hit our hotel last night. Could that be the problem?”

� In my speech class I encountered a number of interesting speeches. This
quote takes the cake, though: “USB 3.0 goes at 3 gigas. That’s almost
the speed of sound!” (I have no idea how he thought a data transfer
speed could be compared to the speed of sound, ignoring the fact that
the speed of sound is roughly 761 miles per hour in air.)

175

http://rinkworks.com/stupid


176 APPENDIX C. QUOTATIONS

� After being told to check the pattern of the switches on the side of a
cash register: “Yeah, you know, I removed them. With a chisel.”

� My dad once worked with a lady who thought she knew everything.
On one particularly memorable occasion, she said, “I know Mouse!”

� Want a good oxymoron? Microsoft Works.

� Ever noticed that MACS backwards is SCAM?

� They say that if you play an AOL CD backwards, you hear Satanic
messages. But that’s nothing. If you play it forwards, it installs AOL!

� To err is human; to really foul things up requires a computer.

� “Do I need a computer to run this software?”

� “Do I have to be online to backup online?”

� After copying a file and receiving the message one file copied : “It says
one copy filed.”

� “It says I have 2 zillion bytes available, and I need 8 zillion.”

� “Well, we have the CD, but we can’t find the ROM!”

� In response to asking a user why he included the line x = x multiple
times in his program code: “So x doesn’t lose its value.”

� “I don’t have a space bar.”

� “Oh my gosh! Plug it out!”

� In response to asking if the caps lock light was on: “I’m not a computer
person.”

� “Do you want a forward backslash?”

� “And you are typing the underscore character?” / “Yes, I call it the
dash.”

� “My modem was hit by lightning. Can you email me another one?”
(This guy didn’t have any basic logic, besides not knowing that you
cannot email hardware.)
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� “Oh, I spilled soup on it. Does that make a difference?”

� While attempting to process a return: “Yeah, the modem didn’t fit in
the slot, so I had to file it down until it would fit.”

� “Is the Internet down?”

� The first words out of a customer’s mouth after calling tech support:
“Cursor’s broke.”

� “I don’t think we have a backup tape.”

� In response to being asked what was on his screen: “Hold on, I’ll call
you back.”

� “I get this error when I check my mail. It says, ‘There are no new
messages.’ ”

� “My system’s on fire. What do I do?”
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Appendix D: About This Book

This book was prepared in LATEX, a free typesetting program. There are two
editions of the PDF file, sixyears-ttg.pdf and sixyears-ttg-book.pdf.
The first is intended for display on a computer screen. The second is intended
for printing and binding. It prints in groups of 16 sheets; to bind, simply
take each group of 16, fold at the middle, and staple. Once you’ve done that,
stick them all together, binder-clip them together, and use some glue down
the binding. After it dries, take some heavy cardstock, cut a small piece to
hold the binding together, and glue it on. After that dries, use another piece
of card to make a cover, and you’re done.

This PDF is:

sixyears-ttg.pdf

If you’ve been a subscriber to the Technical Geekery (and/or Windows Tips)
in the past, thanks for all your support. If you’re new, well, welcome.

———————————–
Copyright 2011 Soren Bjornstad.
This document was originally published at:
http://thetechnicalgeekery.com/tips/books/sixyears-ttg.pdf

Verbatim redistribution of part or all of this book is permitted, provided this
notice is preserved.
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backslashes, see slashes and backslashes

Caps Lock, 15, 71, 72
cell phone control system, 103
checking program version, 74
Chrome, 71

bookmarks, 74
Flash, 71
searching pages, 126

complexity vs. simplicity, 101

displaying on desktop
a toolbar with contents of a folder,

74
version of Windows, 64

efficiency, 131, 147
email services, 57
Excel, resizing columns, 36

files, deleting, 11
Firefox

add-ons, see extensions
bookmarks, 54
browsing full screen, 67
extensions, 71
keeping tabs open, 57
links toolbar, 47
RSS, 61
searching pages, 127
starting quickly, 69

tabs, 11
Flash

in Chrome, 71
forms, filling out, 147

input methods, 87
errors, 88, 89
thought, 90
touch screens, 88
touchpads, 90
typing, see touch typing
voice recognition, 89

instability of Windows, 32, 119
installing Windows, 93
Internet

browsing full screen, 67, 159
desktop shortcuts, 16, 20
keyboard shortcuts, 143
middle mouse button, 151
refreshing the page, 155
RSS, 61
search box, 54
searching the Web, 167
working with tabs, 151
zooming, see Zooming

Internet Explorer 7
browsing full screen, 67
finding text, 128
missing menu bar, 47
RSS, 61
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saving pages, 57
search box, 54, 64
starting quickly, 69
tabs, 44, 45
toolbar, 59

keyboard shortcuts
accessibility, 72
Big, Important, 131
closing windows, 20
Ctrl-Shift-Esc, 46
escape key, 37, 161
finding text, 125, 127
forms, 147
function keys, 28, 36
Internet, 143

refreshing, 156
switching windows, 157
TAB, 148
Windows key, 11, 69
Word cheat sheet, 69

macros, 33, 45
Microsoft Word

avoiding saving over originals, 61
bulleted lists, 12
Clippit, 29, 32, 39, 47, 73
Clippy, see Clippit
macros, 33
personalized menus, 35
saving all open files, 67
shortcut cheat sheet, 69
special characters, 19
toolbars, 27, 31, 63
version 2007

changing to, 43
grammar checker, 59

Work menu, 53

middle mouse button, 151
missing Show Desktop icon, 36
Murphy’s Law, 150

Notepad
automatic time and date, 12
font, 16
printing, 20

operating systems, 119

PDFs, creating, 58
plugging in USB cables, 145
privacy, 95, 115

SeaMonkey, 45
searching, 125
searching Google, 167
security

databases, 82
identity theft, 82
malware, 113
passwords, 79

brute-force attacks, 84
dictionary attacks, 83
guessing, 82
guidelines, 82, 83
keyloggers, 84
password manager, 81
shoulder surfing, 80
what to do if it’s stolen, 85
writing down, 81

social engineering, 84, 113
trust, 113
viruses, see malware
vulnerabilities in programs, 82

slashes and backslashes, 133

taking screenshots, 26, 139
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tech support, 97
toilet paper analogy, 119
touch typing

Dvorak, 62
me learning, 87
security benefits, 80

touching up LCD monitors, 159

unusual keys, 139
Insert, 140
Pause/Break, 141
Print Screen, 139
Scroll Lock, 140
SysRq, 141

Vista, 44, 48, 54, 60
versions, 50

window stuck off-screen, 129
Windows background music, 70
Windows Explorer

changing folder icons, 67
deleting files, 15
jumping quickly to folders, 153
renaming drives, 34
renaming files, 153
resizing columns, 36
rotating pictures, 16
slideshow, 16
toolbar labels, 25
toolbars, 32
views, 27, 36

zooming, 59, 137
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